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LESSON 1 -
REVIEWING THE DESKTOP

In this lesson, you will learn how to:

• Work with the desktop

• Work with the taskbar

• Work with My Computer

• Work with the Recycle Bin
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WORKING WITH THE DESKTOP

! Discussion

The Windows NT desktop is similar in concept to an actual desktop. You can use the
desktop to organize the tools and data you frequently use to accomplish your tasks.
The desktop is completely customizable; you can make it look and work in the way
most suitable for you.

Along with the Start button and its cascading menu structure, the Windows NT
desktop also includes the taskbar. Additionally, the new desktop is built around
objects and the properties that control those objects. For example, as a shortcut, you
can embed objects, such as a frequently used directory (represented as a folder) on
your desktop. You can also select text or data in a document and drag it onto the
desktop. The desktop itself is an object that you can customize by changing its
properties.

The desktop
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WORKING WITH THE TASKBAR

! Discussion

The taskbar refers to the object normally located at the bottom of your desktop (it can
be moved to different locations) in which buttons, representing running applications,
appear whenever you start a program or open a window. To switch between
applications, click the button on the taskbar that represents the application you want to
open. When you close the window, the button associated with the opened application
disappears from the taskbar. In addition, the Start button on the left side of the taskbar
has a menu that allows you to move to any application or document, search for
programs, run Help, or shut down Windows NT.

Other indicators can also appear on the taskbar. For example, a clock may be
displayed. Some additional indicators that may appear include a printer (representing
a print job), a battery (representing power on a portable computer), and a modem
(representing a remote connection).

The taskbar

"
You can modify any indicator item by double-clicking it.

WORKING WITH MY COMPUTER

! Discussion

Windows NT includes a tool called My Computer to help you manage your computer
and its resources. The My Computer icon, which appears by default on the Windows
NT desktop, organizes all of your computer’s resources into a single window. By
double-clicking the icon, you can use My Computer to access any of these resources,
including files, folders, and any printers you may have attached to your computer.
You can also use My Computer to access the Windows NT Control Panel.

The My Computer icon
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WORKING WITH THE RECYCLE BIN

! Discussion

The Recycle Bin is a special folder in Windows NT that stores files when they are
deleted. It is represented by an icon on the desktop that cannot be deleted. You can
access the Recycle Bin after files have been deleted and recover them. Files remain in
the Recycle Bin even after your computer is turned off.

You can limit the size of the Recycle Bin to a percentage of disk space. When the
Recycle Bin is full, the most recently deleted files replace the oldest deleted files.
Files that are stored in the Recycle Bin can be restored, but once the Recycle Bin has
been emptied, the files cannot be recovered.

The Recycle Bin icon
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EXERCISE

THE WINDOWS DESKTOP

# Task

Use the Windows NT desktop to answer the following questions.

1. What Windows NT tool contains the Start button and displays
buttons representing open applications?

2. What Windows NT tool can you use to retrieve files or objects
deleted from your system?





LESSON 2 -
CUSTOMIZING ICONS

In this lesson, you will learn how to:

• Arrange icons on the desktop

• Use Auto Arrange

• Line up icons
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ARRANGING ICONS ON THE DESKTOP

! Discussion

You can place objects on the desktop and move them to any location by dragging the
icons. After placing the icons where you want them, you can make Windows NT line
them up vertically or horizontally. Instead of placing the icons in specific locations,
you can allow Windows NT to arrange the icons for you. All icons, except the default
Windows NT icons, will arrange themselves in columns, starting on the left side of the
screen, in order by your choice of name, type, size, date, or in random order.

"
You must have the Auto Arrange command disabled to move
icons to new locations on the desktop. To disable the Auto
Arrange command, click the right mouse button on the
desktop, select Arrange Icons, and make sure no check
appears next to Auto Arrange. If a check is present, select the
command to uncheck it.

"
If you select the Auto Arrange command, the icons arrange
themselves in columns on the left, in no particular order. If
you try to move an icon to another location on the screen, the
icon will snap to the position at the bottom of the right-most
column and all the other icons will move up into position.

"
The Arrange Icons commands (by Name, by Date, etc.) only
arrange icons placed on the desktop; the default Windows NT
icons are not affected by the commands.

$ Procedures

1. Drag the first icon to a new location on the desktop.

2. Release the mouse button.

% Step-by-Step

Arrange icons on the desktop. Disable the Auto Arrange command, if necessary.
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Steps Practice Data

1. Drag the first icon to a new location on
the desktop.
The icon is dragged to a new location. Drag  to the top

right corner of the desktop

2. Release the mouse button.
The icon is placed in a new location
on the desktop.

Release the mouse button

Drag the Recycle Bin icon to the middle of the desktop, then drag the My Briefcase
icon to the bottom-right corner of the desktop.

USING AUTO ARRANGE

! Discussion

The Auto Arrange command automatically arranges icons on the desktop in an
orderly view. This command is accessible from the Arrange Icons submenu on the
desktop’s shortcut menu. The command can be toggled on or off. When a check
appears next to it, it is enabled. When no check is present, it is disabled.

"
The Auto Arrange command must be disabled to manually
relocate, move, or copy icons to a new location on your
desktop.

$ Procedures

1. Click the right mouse button on a blank area of the desktop.

2. Point to Arrange Icons.

3. If no check appears next to Auto Arrange, select the command to
activate it.

% Step-by-Step

Use the Auto Arrange command to automatically arrange the icons on your desktop.
First, place the icons on the desktop in random locations, if necessary.
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Steps Practice Data

1. Click the right mouse button on a
blank area of the desktop.
A shortcut menu appears.

Click the right mouse
button on a blank area of
the desktop

2. Point to Arrange Icons.
A submenu appears.

Point to Arrange Icons

3. If no check appears next to Auto
Arrange, select the command to
activate it.
The icons on the desktop are
automatically arranged.

Click Auto Arrange, if
necessary

LINING UP ICONS

! Discussion

Icons can be automatically lined up to an invisible grid using the desktop’s shortcut
menu.

"
Only icons added to the desktop can be aligned. Windows NT
automatically arranges default icons.

$ Procedures

1. Click the right mouse button on a blank space on the desktop.

2. Select Line up Icons.
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EXERCISE

CUSTOMIZING ICONS

# Task

Arrange the Windows NT default icons on the desktop. Make sure that the Auto
Arrange command is disabled.

1. Drag the Windows NT default icons to different locations on the
desktop.

2. Line up the icons horizontally.

3. Use the Auto Arrange command to arrange the icons on the
desktop.





LESSON 3 -
USING THE TASKBAR

In this lesson, you will learn how to:

• Hide/display the taskbar

• Move the taskbar

• Use the clock in the taskbar
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HIDING/DISPLAYING THE TASKBAR

! Discussion

By checking the Auto hide option in the Taskbar Properties dialog box, you can hide
the taskbar so that you have one more line on the screen to use. If you hide the
taskbar, it actually becomes a thin line at the bottom of the screen. Pointing to the thin
line redisplays the taskbar. After you use the taskbar, it reverts to a thin line again. If
you use a maximized window when the taskbar is hidden, you may not be able to
access the taskbar. To avoid this problem, check the Always on top option when you
hide the taskbar.

"
You can also access the Taskbar Properties dialog box by
clicking the right mouse button on the taskbar and selecting
the Properties item from the shortcut menu.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Taskbar.

4. Check the Auto hide option.

5. Check the Always on top option.

6. Select OK.

% Step-by-Step

Set the Auto hide option to hide the taskbar. Open the Taskbar Properties dialog box.

Steps Practice Data

1. Check the Auto hide option.
The option is checked.

Check  Auto hide

2. Check the Always on top option.
The option is checked.

Check  Always on
top, if necessary
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Steps Practice Data

3. Select OK.
The taskbar settings are saved.

Click OK

Test Windows NT with the taskbar hidden. Then, disable the Auto hide command by
removing the check from the Auto hide option.

MOVING THE TASKBAR

! Discussion

Although the default position of the taskbar is at the bottom of the screen, it can be
moved by dragging it to the top or either side of the screen.

$ Procedures

1. Drag the taskbar to the top of the desktop.

2. Release the mouse button.

3. Drag the taskbar to the left side of the desktop.

4. Release the mouse button.

5. Drag the taskbar to the right side of the desktop.

6. Release the mouse button.

7. Drag the taskbar to the bottom of the desktop.

8. Release the mouse button.

% Step-by-Step

Move the taskbar to different locations on the desktop.
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Steps Practice Data

1. Drag the taskbar to the top of the
desktop.
The taskbar moves as you drag.

Drag the taskbar to the top
of the desktop

2. Release the mouse button.
The taskbar is relocated.

Release the mouse button

3. Drag the taskbar to the left side of the
desktop.
The taskbar moves as you drag.

Drag the taskbar to the left
side of the desktop

4. Release the mouse button.
The taskbar is relocated.

Release the mouse button

5. Drag the taskbar to the right side of the
desktop.
The taskbar moves as you drag.

Drag the taskbar to the
right side of the desktop

6. Release the mouse button.
The taskbar is relocated.

Release the mouse button

7. Drag the taskbar to the bottom of the
desktop.
The taskbar moves as you drag.

Drag the taskbar to the
bottom of the desktop

8. Release the mouse button.
The taskbar is relocated.

Release the mouse button

USING THE CLOCK IN THE TASKBAR

! Discussion

The clock displays the current time on the right side of the taskbar by default. If you
need more room on the taskbar to see buttons for open programs, you can hide the
clock.

"
If you position your mouse pointer on the taskbar clock,
Windows NT displays the current date.
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Taskbar.

4. Uncheck the Show Clock option.

5. Select OK.

% Step-by-Step

Hide the clock on the taskbar. Open the Taskbar Properties dialog box.

Steps Practice Data

1. Uncheck the Show Clock option.
The option is unchecked.

Uncheck  Show
Clock, if necessary

2. Select OK.
The settings are saved.

Click OK

Notice the difference in the taskbar. Now, return the clock to the taskbar.
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EXERCISE

USING THE TASKBAR

# Task

Use the taskbar.

1. Hide the taskbar.

2. Redisplay the taskbar.

3. Move the taskbar to a different location on the desktop.

4. Hide the taskbar’s clock.

5. Redisplay the taskbar’s clock.

Return the taskbar to its default location at the bottom of the desktop.



LESSON 4 -
MANIPULATING WINDOWS & PROGRAMS

In this lesson, you will learn how to:

• Open a window

• Minimize/Restore a window

• Maximize/Restore a window

• Move a window

• Size a window

• Scroll a window

• Close a window

• Switch windows - taskbar

• Switch windows - keyboard

• Cascade windows

• Tile windows

• Minimize multiple windows
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OPENING A WINDOW

! Discussion

Opening a window in Windows NT is similar to opening a window in Windows 3.1.
Using the mouse to double-click an icon is often the fastest and easiest way to open a
window. This method also can be used to start a program, since a Windows-based
program runs within a window. If an icon of a program appears on the desktop,
double-clicking the icon to open a window starts the program.

"
You can also open a window by selecting an icon; clicking the
right mouse button on the selected icon, and selecting Open
from the shortcut menu.

$ Procedures

1. Double-click an icon on the desktop containing the item you want to
open into a window.

% Step-by-Step

Open a window.

Steps Practice Data

1. Double-click an icon on the desktop
containing the item you want to open
into a window.
A window opens displaying the
selected item.

Double-click 
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MINIMIZING/RESTORING A WINDOW

! Discussion

Minimizing a window or an application reduces it to a raised button on the taskbar and
puts it into a temporarily inactive state. To help conserve system resources, it is a
good idea to minimize windows when you have a number of windows open or when
you are multitasking.

The fastest method to minimize a window is to use the Minimize button in the upper-
right corner of the window. Although different in appearance, the Minimize button in
Windows NT performs the same task as the Minimize button in Windows 3.1.
However, Windows NT displays minimized applications as buttons on the taskbar,
whereas Windows 3.1 displays minimized applications as icons.

In Windows NT, as in Windows 3.1, restoring a window returns the window to its
previous size and shape. The most convenient method of restoring a minimized
window is clicking the button on the taskbar representing the window or application.

"
You can also minimize a window or application by clicking
the right mouse button on a window’s title bar and selecting
the Minimize command from the shortcut menu.

"
You can also restore a minimized window or application by
clicking the right mouse button on the window’s button on the
taskbar and selecting the Restore command from the shortcut
menu.

$ Procedures

1. Click the Minimize button.

2. From the taskbar, click the button with the title matching the name of
the item you want to restore.

% Step-by-Step

Minimize a window, and then restore it to its original size. If a window is not
currently open, open one.
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Steps Practice Data

1. Click the Minimize button.
The item disappears from the desktop
and its title is placed in a button on the
taskbar.

Click 

2. From the taskbar, click the button with
the title matching the name of the item
you want to restore.
The item appears on the desktop.

Click the button on the
taskbar that represents the
minimized item

MAXIMIZING/RESTORING A WINDOW

! Discussion

Maximizing a window enlarges the window to a full screen view. The fastest way to
maximize a window is by clicking the Maximize button in the upper-right corner of
the window. Although different in appearance, the Maximize button in Windows NT
performs the same task and produces the same results as the Maximize button in
Windows 3.1.

In Windows NT, as in Windows 3.1, restoring a maximized window returns it to its
previous size and shape. The most convenient way of restoring a maximized window
is clicking the Restore button in the upper-right corner of the window.

"
You can also maximize a window by clicking the right mouse
button on the window’s title bar and selecting the Maximize
command from the shortcut menu.

$ Procedures

1. Click the Maximize button.

2. Click the Restore button.

% Step-by-Step

Maximize a window and then restore it. If a window is not currently open, open one.
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Steps Practice Data

1. Click the Maximize button.
The window appears in full screen
mode.

Click 

2. Click the Restore button.
The item appears in a window on the
desktop.

Click 

MOVING A WINDOW

! Discussion

As in Windows 3.1, you can move and arrange open windows in Windows NT using
drag and drop. Dragging a window’s title bar to a new location moves the entire
window. This method is useful when you are working with multiple open windows or
applications that need to be viewed simultaneously.

$ Procedures

1. Drag the window to the desired location.

2. Release the mouse button.

% Step-by-Step

Move a window. If a window is not currently open, open one.

Steps Practice Data

1. Drag the window to the desired
location.
The window becomes the active
window.

Hold the left mouse button
on the window’s title bar
and drag the window up
approximately 1/2 inch

2. Release the mouse button.
The window is repositioned.

Release the mouse button
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SIZING A WINDOW

! Discussion

As in Windows 3.1, Windows NT allows you to manually adjust the size of a window.
This option can be used to adjust how much of a window’s contents can be viewed or
to improve visibility of other windows or areas on your desktop. Sizing a window
involves dragging the window’s border to enlarge, reduce, or change the shape of the
window.

"
A window cannot be sized when it is minimized or
maximized.

$ Procedures

1. Point to one of the window borders and drag the mouse pointer.

2. Release the mouse button.

% Step-by-Step

Change a window’s size and shape. If a window is not currently open, open one.

Steps Practice Data

1. Point to one of the window borders
and drag the mouse pointer.
The mouse pointer changes to a
double-headed arrow.

Point to the bottom-right
corner of the window and
drag the window corner up
and to the left until
horizontal and vertical
scroll bars appear

2. Release the mouse button.
The window is resized.

Release the mouse button
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SCROLLING A WINDOW

! Discussion

Scrolling windows in Windows 95 is identical to scrolling windows in Windows 3.1.
If an opened window contains more objects than can be viewed, a scroll bar appears to
the right and/or the bottom of the window. The number of objects in a window
appears at the bottom of the window in the window’s status bar.

"
You can also use the arrow keys to scroll through the active
window.

$ Procedures

1. Click a scroll bar button to move line-by-line through the window.

2. Drag the scroll box until the objects you want to view appear.

3. Release the mouse button.

% Step-by-Step

Scroll within an open window. If necessary, open the My Computer window and, if
the window does not contain scroll bars, reduce the size of the window until they
appear.

Steps Practice Data

1. Click a scroll bar button to move line-
by-line through the window.
The contents of the window move one
line.

Click 

2. Drag the scroll box until the objects
you want to view appear.
The scroll box moves as you drag.

Drag 
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Steps Practice Data

3. Release the mouse button.
The contents of the window move in
the same direction as the scroll box.

Release the mouse button

CLOSING A WINDOW

! Discussion

Closing windows in Windows 95 involves a similar procedure to closing windows in
Windows 3.1. Where every windows in Windows 3.1 has a Close button in its upper-
left corner, every window in Windows NT has a Close button in its upper-right
corner. In Windows 3.1, however, you have to double-click the button to close a
window or terminate an application, where you only need to click the button in
Windows NT.

"
Many windows contain pull-down menus. The File pull-down
menu contains the Close command that can be used to close a
window or terminate an application. The Close command can
also be accessed by clicking the right mouse button on the
window’s title bar. Exiting Windows-based programs can be
done using the same method.

$ Procedures

1. Click the Close button.

% Step-by-Step

Open a window, if necessary.

Steps Practice Data

1. Click the Close button.
The window closes.

Click 
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SWITCHING WINDOWS - TASKBAR

! Discussion

The Windows NT taskbar displays all minimized applications and windows as
buttons. You can use the taskbar to switch quickly between applications and windows
by clicking the appropriate button. Since the taskbar is normally visible on your
desktop, you can always see which programs or windows are open and quickly switch
to them.

Buttons on the taskbar display the titles or names of the windows or applications that
are running minimized. When numerous programs or windows are open, buttons on
the taskbar may display abbreviated names due to space constraints.

"
You can also use the [Alt+Esc] key combination to toggle
through applications on the taskbar.

"
If multiple windows are open and overlapped, the active
window appears on top. The title bar of the active window is
highlighted.

$ Procedures

1. On the taskbar, click the button with the title that matches the name
of the item you want to access.

2. From the taskbar, switch to a previously opened item by clicking
another button.

% Step-by-Step

Use the taskbar to switch between open windows.  Open My Computer and the
Recycle Bin and minimize them.
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Steps Practice Data

1. On the taskbar, click the button with
the title that matches the name of the
item you want to access.
The window appears in the forefront of
the desktop.

Click the My Computer
button

2. From the taskbar, switch to a
previously opened item by clicking
another button.
The window appears in the forefront of
the desktop.

Click the Recycle Bin
button

SWITCHING WINDOWS - KEYBOARD

! Discussion

In Windows NT, as in Windows 3.1, you can use the keyboard to switch between running
applications. Although the [Alt+Tab] key combination is identical, and the end result of
moving between programs is the same as in Windows 3.1, the graphics used in Windows NT
to represent the process are slightly different. Pressing the key combination displays a pane
with icons of all folders or applications currently running. As you hold the [Alt] key and press
the [Tab] key, different folders or applications are selected within the pane. A description of
the selected icon appears at the bottom of the pane.

"
You can also use the [Alt+Esc] key combination to toggle
between windows. The selected window appears depressed on
the taskbar.

$ Procedures

1. Hold [Alt].

2. Press [Tab]. Repeat to cycle through the icons for the open
programs.

3. Release [Alt].
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% Step-by-Step

Use the keyboard to switch between open windows. If necessary, open two windows.

Steps Practice Data

1. Hold [Alt].
The task switching mode becomes
active.

Hold [Alt]

2. Press [Tab]. Repeat to cycle through
the icons for the open programs.
The task switching window appears
displaying the icons for the active
tasks.

Press [Tab]

3. Release [Alt].
The selected task is restored to the
foreground of the desktop.

Release [Alt]

CASCADING WINDOWS

! Discussion

Windows NT allows you to cascade open windows with the Cascade command. Once
windows have been cascaded, you can undo the option with the Undo Cascade
command on the taskbar’s shortcut menu. Using this command restores windows to
their previous positions on your desktop.
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Cascading open windows

&
Before you select the Cascade command, make sure that all
the windows you want to display are open. Closed or
minimized windows will not appear.

$ Procedures

1. Click the right mouse button on a blank area of the taskbar.

2. Select Cascade.

3. Click the right mouse button on a blank area of the taskbar.

4. Select Undo Cascade.

% Step-by-Step

Cascade open windows, and then undo all cascaded windows. If necessary, open at
least two windows.
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Steps Practice Data

1. Click the right mouse button on a
blank area of the taskbar.
A shortcut menu appears.

Click the right mouse
button on a blank area of
the taskbar

2. Select Cascade.
All open windows appear cascaded.

Click Cascade

3. Click the right mouse button on a
blank area of the taskbar.
A shortcut menu appears.

Click the right mouse
button on a blank area of
the taskbar

4. Select Undo Cascade.
All cascaded windows are restored to
their previous settings.

Click Undo Cascade

TILING WINDOWS

! Discussion

You can arrange open windows to display on screen as vertically tiled. When you tile
windows vertically, they display edge-to-edge next to each other with the windows
stretching from the top of the display to the bottom. If more than three windows are
open, they tile both vertically and horizontally in a view that is automatically set by
Windows NT.

You can also arrange open windows to display on screen as horizontally tiled. When
you tile windows horizontally, they display edge-to-edge on top of each other with the
windows stretching from the left of the display to the right.

Windows NT allows you to undo all tiled windows with the Tile Horizontally or Tile
Vertically command. Once windows have been tiled, the Undo Tile command is
available from the taskbar’s shortcut menu. Using this command restores windows to
their previous positions on your desktop.
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Tiling windows vertically

&
Before you select the Tile Vertically or Tile Horizontally
command, make sure that all the windows you want to display
are open. Closed or minimized windows will not display.

$ Procedures

1. Click the right mouse button on a blank area of the taskbar.

2. Select Tile Vertically.

3. Click the right mouse button on a blank area of the taskbar.

4. Select Undo Tile.

% Step-by-Step

Display open windows as vertically tiled, then undo all tiled windows. If necessary,
open at least two windows.
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Steps Practice Data

1. Click the right mouse button on a
blank area of the taskbar.
A shortcut menu appears.

Click the right mouse
button on a blank area of
the taskbar

2. Select Tile Vertically.
All open windows appear tiled.

Click Tile Vertically

3. Click the right mouse button on a
blank area of the taskbar.
A shortcut menu appears.

Click the right mouse
button on a blank area of
the taskbar

4. Select Undo Tile.
All tiled windows are restored to their
previous settings.

Click Undo Tile

MINIMIZING MULTIPLE WINDOWS

! Discussion

When working with multiple open windows or applications, you may want to minimize them
all at once for quick access to the desktop. Windows NT allows you to minimize all open
windows simultaneously using the Minimize All Windows command on the taskbar’s shortcut
menu.

Alternately, when working with multiple minimized windows or applications, you may want to
restore them all at once for quick access to programs and data. Windows NT allows you to
restore all minimized windows simultaneously using the Undo Minimize All command on the
taskbar’s shortcut menu. This command is only available if you used the Minimize All
Windows command to minimize the windows.

$ Procedures

1. Click the right mouse button on a blank area of the taskbar.

2. Select Minimize All Windows.

3. Click the right mouse button on a blank area of the taskbar.

4. Select Undo Minimize All.
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% Step-by-Step

Minimize open windows simultaneously and then restore them. If necessary, open at
least two windows.

Steps Practice Data

1. Click the right mouse button on a
blank area of the taskbar.
A shortcut menu appears.

Click the right mouse
button on a blank area of
the taskbar

2. Select Minimize All Windows.
All open windows are minimized.

Click Minimize All
Windows

3. Click the right mouse button on a
blank area of the taskbar.
A shortcut menu appears.

Click the right mouse
button on a blank area of
the taskbar

4. Select Undo Minimize All.
All minimized windows are restored.

Click Undo Minimize
All

Close all open windows.
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EXERCISE

WORKING WITH WINDOWS

# Task

Work with windows in Windows NT.

1. Open three windows from the desktop.

2. If necessary, resize the top window so that all of its contents are not
visible and the horizontal and vertical scroll bars appear.

3. Scroll through the window to view its contents.

4. Resize the window to make it larger.

5. Maximize the window.

6. Minimize the window.

7. Use the taskbar to switch to any window.

8. Use [Alt+Tab] to move through the open windows.

9. Make sure all three windows are not minimized, and then cascade
them.

10. Tile the windows vertically, then horizontally.

11. Undo the horizontal tiling.

12. Minimize all windows simultaneously, then restore them.

13. Close all open windows.





LESSON 5 -
SELECTING MULTIPLE OBJECTS

In this lesson, you will learn how to:

• Select a block

• Select multiple objects
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SELECTING A BLOCK

! Discussion

Windows NT allows you to select a consecutive block of objects in a window, which
then can be cut, copied, or deleted as a group. This method is useful when you want to
quickly select a group of objects and perform a specific action on them.

"
You can select multiple objects by using the mouse pointer to
draw a box around the objects.

$ Procedures

1. Click the first object in the list to be blocked.

2. Hold [Shift] and click the last object in the list to be selected.
Release [Shift].

% Step-by-Step

Select a consecutive block of documents in the Multiple Objects Folder. Use My
Computer to open the Multiple Objects Folder in the Student Data Folder.

Steps Practice Data

1. Click the first object in the list to be
blocked.
The object is selected. Click 

2. Hold [Shift] and click the last object in
the list to be selected. Release [Shift].
A consecutive block of objects is
selected.

Hold [Shift], click

, and release
[Shift]

Click anywhere in the open window to deselect the block.
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SELECTING MULTIPLE OBJECTS

! Discussion

Windows NT allows you to select multiple objects randomly positioned in a window,
which then can be cut, copied, or deleted as a group. This method is useful when you
want to quickly select a group of objects and perform a specific action on them.

$ Procedures

1. Click the first object to be grouped.

2. Hold [Ctrl] and click the next object to be grouped.

3. Repeat step 2 for different objects, as necessary. Release [Ctrl] when
finished selecting objects.

% Step-by-Step

Select a group of documents in the Multiple Objects Folder. Use My Computer to
open the Multiple Objects Folder in the Student Data Folder.

Steps Practice Data

1. Click the first object to be grouped.
The object is selected.

Click 

2. Hold [Ctrl] and click the next object
to be grouped.
The object is selected.

Hold [Ctrl] and click

3. Repeat step 2 for different objects, as
necessary. Release [Ctrl] when
finished selecting objects.
Objects are selected as desired to
compose a group.

Click  and
release [Ctrl]

Click anywhere in the open window to deselect the selected objects.
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EXERCISE

SELECTING MULTIPLE OBJECTS

# Task

Select multiple objects. Open the Memos Sent folder in the Student Data Folder
before proceeding.

1. Select a block of files consisting of the first four files in the folder.
First, use the [Shift] key and the mouse to select the first four files in
the folder. Then, deselect the files by selecting any other single file.
Finally, select the same four files again using just the mouse.

2. Select a group of non-contiguous files using the mouse and the
[Ctrl] key. First, select the Depts. file. Then, select the Hours
Worked and the Timesheet files.

3. The Depts., Hours Worked, and Timesheet files should still be
selected. Invert the selection so that the other files in the folder are
selected.

Close all open windows.



LESSON 6 -
WORKING IN FOLDER WINDOWS

In this lesson, you will learn how to:

• Use the View toolbar

• Use the status bar in folders

• Change the display of objects
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USING THE VIEW TOOLBAR

! Discussion

You can access the toolbar from the View pull-down menu in any folder window.
When the Toolbar command is selected from the View pull-down menu (a check
appears beside it) buttons and controls appear at the top of the folder window. These
buttons and controls allow you to manipulate the folder window as well as the objects
that appear in the folder. To suppress the display of the toolbar, select the Toolbar
command again (the check beside it disappears).

Button/Control Button/Control
Name

Function

Go To A Different
Folder

Changes the resource
displayed in the
window.

Up One Level Opens the window
(parent folder) from
which you accessed the
current window.

Map Network Drive Maps a network-based
hard drive to a
specified drive letter. *

Disconnect Net
Drive

Disconnects you from
a network-based hard
drive. *

Cut Removes a selected
object from the folder
and copies it to the
Clipboard.

Copy Copies a selected
object from the folder
to the Clipboard.

Paste Inserts a cut or copied
object from the
Clipboard into a
specified location.

Undo Reverses the last action
performed within the
window.
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Button/Control Button/Control
Name

Function

Delete Deletes a selected
object from the folder
window.

Properties Displays the properties
of a selected object in a
Properties dialog box.

Large Icons Displays objects in the
window with large
icons.

Small Icons Displays objects in the
window with small
icons.

List Displays objects in the
window in a list
format.

Details Displays detailed
information about
objects in the window.

* This option is available only if the folder can interface with the network, e.g., the My
Computer folder contains this option because it allows you to view the contents of your
computer as well as manage your files on a network.

$ Procedures

1. Select the View pull-down menu.

2. Select Toolbar.

3. Select an object that you want to manipulate using the toolbar.

4. Select a control or button on the toolbar to manipulate the open
folder or the selected objects.

% Step-by-Step

Display a window toolbar. Maximize the Student Data Folder window located on your
diskette, if necessary.
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Steps Practice Data

1. Select the View pull-down menu.
A submenu appears.

Click View

2. Select Toolbar.
A toolbar appears at the top of the
folder window.

Click Toolbar

3. Select an object that you want to
manipulate using the toolbar.
The object is selected.

Click 

4. Select a control or button on the
toolbar to manipulate the open folder
or the selected objects.
The folder or objects react to the
control or button selected.

Click 

Close the Properties dialog box and hide the toolbar.

USING THE STATUS BAR IN FOLDERS

! Discussion

The status bar, which is accessed from the View pull-down menu in any object or
folder window, provides information about the commands and menu items associated
with the open folder. When the status bar is selected from the View pull-down menu
(a check appears beside it), the status bar displays descriptive information at the
bottom of the window. To suppress the display of status bar information, select the
Status Bar command again (the check beside it disappears).

$ Procedures

1. Select the View pull-down menu.

2. Select Status Bar.

% Step-by-Step

Display the status bar.
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Steps Practice Data

1. Select the View pull-down menu.
The View pull-down menu appears.

Click View

2. Select Status Bar.
A status bar appears at the bottom of
the folder window.

Click Status Bar

Hide the status bar.

CHANGING THE DISPLAY OF OBJECTS

! Discussion

The View pull-down menu, which is accessible from any object or folder window,
contains commands that allow you to change the way objects are displayed. These
commands include the following: Large Icons (default), Small Icons, List, and
Details. You can choose the Large Icons option to display objects with larger-sized
labeled icons or you can choose the Small Icons option to display objects with
smaller-sized labeled icons. If you want to display objects in a list, select the List
option. This option displays a smaller-sized icon along with a description of the object
in a list format. You can also display a detailed list of objects by selecting the Details
option. This option displays an icon, the object’s name, size, type, and the date the
object was last modified.

$ Procedures

1. Select the View pull-down menu.

2. Select Small Icons.

3. Select the View pull-down menu.

4. Select List.

5. Select the View pull-down menu.

6. Select Details.

% Step-by-Step

Change the view to display small icons, list, and details.
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Steps Practice Data

1. Select the View pull-down menu.
The View pull-down menu appears.

Click View

2. Select Small Icons.
The objects appear with smaller-sized
labeled objects.

Click Small Icons

3. Select the View pull-down menu.
The View pull-down menu appears.

Click View

4. Select List.
The objects appear in a list format.

Click List

5. Select the View pull-down menu.
The View pull-down menu appears.

Click View

6. Select Details.
The objects appear with detailed
information.

Click Details

Return the view to large icons and close any open windows.
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EXERCISE

WORKING IN FOLDER WINDOWS

# Task

Work in folder windows.

1. Open any folder window.

2. Display the toolbar, if necessary.

3. Display the status bar, if necessary. Notice the number of objects in
the folder window.

4. Display objects in the folder as large icons, small icons, in a list, and
with details. Return the display to its default of large icons.

5. Arrange objects in the folder window, first by date, then by name,
type, and size.

6. Close all open windows.





LESSON 7 -
USING MENUS AND DIALOG BOXES

In this lesson, you will learn how to:

• Use menus

• Use the Start menu

• Close a "locked" program

• Use dialog boxes

• Use shortcut menus

• Open programs - shortcut menus

• Move using shortcut menus

• Copy using shortcut menus

• Use drag and drop to copy

• Use drag and drop to move

• Use property sheets
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USING MENUS

! Discussion

Windows NT contains various types of menus to help you access applications, files,
folders, and objects. The menu types include the Start menu, submenus, and shortcut
menus.

The Start menu, which appears when the Start button is clicked, includes menu items
that allow you to access programs, documents, and objects on the desktop. The Start
menu also includes commands for running programs from a command line, setting
system options, and shutting down Windows.

Submenus are cascading menus that are accessed from other menus and/or
applications. They are identified by a small right arrow at the right edge of a menu
item. When you click a menu item that contains a submenu, a related menu appears.
This submenu may contain commands, applications, other submenus, or a
combination of all three.

Shortcut menus include menu items that allow you to perform various functions or set
properties for a selected object. By clicking the right mouse button on an item, a
shortcut menu appears. From the displayed shortcut menu, you can make a selection
to execute any of the commands listed.

A menu
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USING THE START MENU

! Discussion

The Start menu and its cascading submenus contain programs, documents, folders,
and files that can be opened into windows. The Start menu is opened through the
Start button. Unlike the desktop, the Start button is part of the taskbar and is always
visible on your screen regardless of the application you are running. The Start menu
provides a quick and easy way to open an object into a window. However, the item
you wish to open must be present on the Start menu for it to be accessible. The Start
menu is also customizable; depending on your computer and the options that you have
selected, other menu items may appear.

The Start menu also contains a list of commands you can use to work with Windows
NT. Some menu commands on the Start menu are followed by an arrow. The arrow
indicates that a submenu is available for that item. When you point to the item, its
submenu appears. Items without an arrow must be clicked or selected to open a
window or program.

Command Function

Programs Displays a cascading submenu of available
programs.

Documents Displays a list of up to the last 15
previously opened documents.

Settings Displays a cascading submenu of system
settings that can be modified.

Find Displays a cascading submenu with
options that open a Find dialog box which
allows you to find a folder, file, shared
computer, or items on the Microsoft
Network.

Help Opens Windows NT on-line Help.

Run Opens the Command dialog box, which
allows you to enter a MS-DOS command
to start a program or open a folder.

Shut Down Opens the Shut Down Windows dialog
box that contains commands to restart or
shut down your computer.
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The Start menu

$ Procedures

1. Click the Start button.

2. Point to an option on the Start menu.

3. If applicable, continue to select submenus until the item you want to
open appears.

4. Select the item to be opened.

% Step-by-Step

Access an item from the Start menu.

Steps Practice Data

1. Click the Start button.
The Start menu appears.

Click  Start

2. Point to an option on the Start menu.
The item appears on the screen or, if
the option has an arrow displayed to
its right, a submenu appears.

Point to  Programs
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Steps Practice Data

3. If applicable, continue to select
submenus until the item you want to
open appears.
Cascading submenus continue to
appear.

Point to 
Accessories

4. Select the item to be opened.
The item appears on the screen.

Click  WordPad

CLOSING A "LOCKED" PROGRAM

! Discussion

You can exit any program, or end any task, by using the keyboard to open the Close
Program dialog box. This procedure is useful if your program should “lock up” or
experience technical problems. The Close Program dialog box allows you to select
any running task from a list and end the task. You can also restart your system from
this dialog box.

$ Procedures

1. Press [Ctrl+Alt+Delete].

2. Under the Windows NT Security Window, select the Task
Manager button.

3. Select the program you want to close from the list of running
programs.

4. Select End Task.

% Step-by-Step

Use the Close Program dialog box to close the WordPad program. Open WordPad, if
necessary.



Lesson 7 - Using Menus and Dialog Boxes Windows NT Basics

Page 54 University Technology Training Center

Steps Practice Data

1. Press [Ctrl+Alt+Delete].
The Close Program dialog box opens.

Press [Ctrl+Alt+Delete]

2.   Under the Windows NT Security
Window, select the Task Manager
button.

Select Task Manager

2. Select the program you want to close
from the list of running programs.
The program name appears selected in
the list.

Click Document -
WordPad

3. Select End Task.
The selected task ends and the Close
Program dialog box closes.

Click End Task

USING DIALOG BOXES

! Discussion

A dialog box is a type of window containing controls that set options and establish an
application’s appearance and function. Some of the most common dialog box options
include the following:

Option Function

Text box Used to enter text-based information.

Command button Initiates an action when clicked.

Check box Allows you to enable an option (by
checking the box), or disable an option (by
unchecking the box).

Option button Allows you to select one option out of a
group of options.

List box Displays a list of choices.

Combo box Displays a combination text and list box.

Scroll bar (Slider) Allows you to set a value from a range by
moving an indicator to a desired value.
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The Print Help dialog box

"
Windows NT includes common dialog boxes that are used by
various Windows applications. Common dialog boxes help to
establish uniformity among all applications created for use
with Windows. These dialog boxes perform actions such as
printing, opening, and saving files as well as selecting fonts.

USING SHORTCUT MENUS

! Discussion

Whenever you click an item using the right mouse button, a shortcut menu appears. A
shortcut menu allows you to perform different functions on, and set properties for, the
selected object. For example, clicking the right mouse button on the desktop displays
a shortcut menu that provides access to property sheets (among other commands) for
the desktop. These property sheets allow you to set the display’s colors, screen savers,
and resolution for the Windows NT desktop.
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The desktop's shortcut menu

$ Procedures

1. Click the right mouse button on an item.

% Step-by-Step

Access a shortcut menu.

Steps Practice Data

1. Click the right mouse button on an
item.
A shortcut menu appears.

Click the right mouse
button on an item

Click outside of the shortcut menu to close it.

OPENING PROGRAMS - SHORTCUT MENU

! Discussion

The shortcut menu provides an alternative method for launching a program. You can
open any program that appears as an icon by clicking the shortcut menu’s Open
command.
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The Recycle Bin’s shortcut menu

$ Procedures

1. Click the right mouse button on the icon representing the program
you want to open.

2. Select Open from the shortcut menu.

% Step-by-Step

Use a shortcut menu to open a program.

Steps Practice Data

1. Click the right mouse button on the
icon representing the program you
want to open.
The program’s shortcut menu appears.

Click the right mouse

button on 

2. Select Open from the shortcut menu.
The program starts.

Click Open

Close the Recycle Bin.
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MOVING USING SHORTCUT MENUS

! Discussion

You can move an object by using menu commands accessed from the object’s
shortcut menu. Moving an object, however, physically places it in another location
and a copy of it does not remain in the original location.

"
To move objects on the desktop, the Auto Arrange command
must be turned off. Perform this task by clicking the right
mouse button on the desktop, pointing to Arrange Icons, and
making sure that the Auto Arrange command does not have a
check next to it.

$ Procedures

1. Hold the right mouse button on the object you want to move and
drag it to a new location.

2. Release the right mouse button.

3. Select Move Here.

% Step-by-Step

Move an object using a shortcut menu.

Steps Practice Data

1. Hold the right mouse button on the
object you want to move and drag it to
a new location.
The object moves as you drag.

Hold the right mouse

button on 
and drag it to another
location on the desktop

2. Release the right mouse button.
A shortcut menu appears.

Release the right mouse
button
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Steps Practice Data

3. Select Move Here.
The object moves to the destination
location.

Click Move Here

COPYING USING SHORTCUT MENUS

! Discussion

You can copy an object by using menu commands accessed from the object’s shortcut
menu. Copying an object, however, only moves a copy of the object to a destination
location. The original object remains unchanged at its current location.

"
To move objects on the desktop, the Auto Arrange command
must be turned off. Perform this task by clicking the right
mouse button on the desktop, pointing to Arrange Icons, and
making sure that the Auto Arrange command does not have a
check next to it.

$ Procedures

1. Hold the right mouse button on the object to be copied and drag it to
a new location.

2. Release the right mouse button.

3. Select Copy Here.

% Step-by-Step

Copy an object using a shortcut menu.
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Steps Practice Data

1. Hold the right mouse button on the
object to be copied and drag it to a
new location.
The object moves as you drag.

Hold the right mouse

button on 
and drag it to another
location on the desktop

2. Release the right mouse button.
A shortcut menu appears.

Release the right mouse
button

3. Select Copy Here.
The object is copied to the destination
location.

Click Copy Here

Delete the Copy of My Briefcase icon by selecting it, pressing [Delete], and selecting
Yes.

USING DRAG AND DROP TO COPY

! Discussion

You can copy objects by using drag and drop. This method allows you to select an
object and use the mouse to drag a copy of it to a destination location. Copying an
object, however, only moves a copy of the object to a destination location. The
original object remains unchanged at its current location.

"
Objects can be copied to and from the desktop or any window.

$ Procedures

1. Hold [Ctrl] and drag the object to be copied.

2. Release the mouse button and then [Ctrl].

% Step-by-Step

Copy an object using drag and drop.
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Steps Practice Data

1. Hold [Ctrl] and drag the object to be
copied.
The object moves as you drag.

Hold [Ctrl] and drag

 to another
location on the desktop

2. Release the mouse button and then
[Ctrl].
The object is copied to the destination
location.

Release the mouse button
and then [Ctrl]

Delete the Copy of My Briefcase icon by selecting it, pressing [Delete], and selecting
Yes.

USING DRAG AND DROP TO MOVE

! Discussion

You can move objects by using drag and drop. This method allows you to select an
object and use the mouse to drag it to a destination location. Moving an object,
however, physically moves it to another location, and a copy of it does not remain in
the original location.

"
To move objects on the desktop, the Auto Arrange command
must be turned off. Perform this task by clicking the right
mouse button on the desktop, pointing to Arrange Icons, and
making sure that the Auto Arrange command does not have a
check next to it.

&
While clicking the left mouse button and dragging a file
between two folders on the same drive moves the file;
dragging a file between different drives copies it instead.

$ Procedures

1. Drag the object to a new location.
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2. Release the mouse button.

% Step-by-Step

Move an object using drag and drop.

Steps Practice Data

1. Drag the object to a new location.
The object moves as you drag.

Drag  to
another location on the
desktop

2. Release the mouse button.
The object moves to the destination
location.

Release the mouse button

USING PROPERTY SHEETS

! Discussion

A property sheet is a type of dialog box that allows you to set an object’s properties.
Some objects may have more than one property sheet associated with them. Typically,
a property sheet appears when you click the right mouse button on an object and select
the Properties command from the shortcut menu displayed.

When a property sheet is accessed, it appears on screen with a labeled tab at the top to
identify it. To access a different property sheet, click the sheet’s tab and that sheet
moves to the foreground.
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Property sheets

"
Select Apply if you want the Display Properties window to
remain open so that you can continue to make other changes
before closing the window.

$ Procedures

1. Click the right mouse button on the object you want to modify.

2. Select Properties from the shortcut menu.

3. Select the tab of the property sheet you want to access.

4. Change any property settings as desired.

5. Select OK to apply the new properties and close the property sheet.
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% Step-by-Step

Access a property sheet and change a setting.

Steps Practice Data

1. Click the right mouse button on the
object you want to modify.
A shortcut menu appears.

Click the right mouse
button on the desktop

2. Select Properties from the shortcut
menu.
The property sheets associated with
the item appear.

Click Properties...

3. Select the tab of the property sheet you
want to access.
The selected sheet moves to the
foreground.

Click Screen Saver

4. Change any property settings as
desired.
The settings are modified in the
property sheet.

Accept the defaults

5. Select OK to apply the new properties
and close the property sheet.
The properties are applied
immediately and the window closes.

Click OK
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EXERCISE

MENUS & DIALOG BOXES

# Task

Manipulate menus and dialog boxes in Windows NT.

1. From the Start menu, access the WordPad application. Once the
application opens, close it.

2. Next, retrieve the shortcut menu for the desktop. Review its contents,
then close it.

3. Now, access the Screen Saver property sheet associated with your
desktop. Change your screen saver to Starfield Simulation.

4. Next, use a shortcut menu to copy the My Briefcase object to
another location on the desktop. Once the copy has been created,
delete it.

5. Finally, use drag and drop to move the My Briefcase object to
another location on the desktop. Then, move it back to its original
location.

"
To move objects on the desktop, the Auto Arrange command
must be turned off.





LESSON 8 -
USING MY COMPUTER

In this lesson, you will learn how to:

• Work with folders

• View resources

• Change the view

• View the hard drive

• View a diskette

• Start a program
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WORKING WITH FOLDERS

! Discussion

In Windows NT, file management is based on files and folders. Folders are the
equivalent of directories. They store files and can be created, renamed, moved, copied,
and deleted, just like directories. Sub-directories are also shown as folders. Files
inside folders appear as icons of spreadsheets, documents, or other objects.

Folders are used throughout Windows NT. For example, when you view the contents
of storage devices in My Computer or in the Windows NT Explorer, folders appear.
Double-clicking a folder opens a folder window that displays additional folders and
files stored within that folder. Folders can also appear on the desktop.

A folder icon

VIEWING RESOURCES

! Discussion

You can use My Computer to view and quickly access available resources such as
folders and files located on your hard drive, diskette drive, or any network drive to
which you have access. The My Computer window also displays an icon for the
Control Panel, available printers, and Dial-Up Networking, if it is installed on your
system.

Displaying available resources
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$ Procedures

1. Double-click the My Computer icon.

% Step-by-Step

Use My Computer to view computer resources.

Steps Practice Data

1. Double-click the My Computer icon.
The My Computer window opens,
displaying system resources. Double-click 

CHANGING THE VIEW

! Discussion

You can change the way in which the contents of a folder are displayed in a window
by changing its view. You can increase or decrease the size of icons displayed in a
window; display icons in a list format, or include details. By default, My Computer
displays its contents in large icon view. Changing the view to small icons and viewing
icons in a list are both useful when there are numerous icons in the window. The
Details view lists resources available to your computer and displays resource type,
total size, and the available space of all storage devices to which your computer has
access. This view is useful in determining how much storage space you have used and
how much is available.
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         The Details view

"
You can change the view in any window.

"
When you select a storage device icon in the My Computer
window, Free Space and Capacity, except for floppy drives,
appear in the status bar at the bottom of the window.

$ Procedures

1. Select the View pull-down menu.

2. Select Small Icons.

3. Select the View pull-down menu.

4. Select List.

5. Select the View pull-down menu.

6. Select Details.

7. Select the View pull-down menu.

8. Select Large Icons.

% Step-by-Step

Experiment with different views in the My Computer window. Open the My
Computer window, if necessary.
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Steps Practice Data

1. Select the View pull-down menu.
The View pull-down menu appears.

Click View

2. Select Small Icons.
The My Computer window displays its
contents with small icons.

Click Small Icons

3. Select the View pull-down menu.
The View pull-down menu appears.

Click View

4. Select List.
The My Computer window displays its
contents in a list format.

Click List

5. Select the View pull-down menu.
The View pull-down menu appears.

Click View

6. Select Details.
The My Computer window displays its
contents with details visible.

Click Details

7. Select the View pull-down menu.
The View pull-down menu appears.

Click View

8. Select Large Icons.
The My Computer window displays its
contents with large icons, its default
view.

Click Large Icons

Be sure to return the My Computer window to its default view of large icons.

VIEWING THE HARD DRIVE

! Discussion

The My Computer icon organizes all of your computer’s resources into one window.
My Computer is a useful tool for viewing the contents of your hard drive and for
accessing folders and files.

$ Procedures

1. Double-click the icon for the C: drive.

2. To view the contents of any folders that may be on the C: drive,
double-click the folder’s icon.
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% Step-by-Step

Use My Computer to view the contents of your hard disk drive. Open the My
Computer window, if necessary.

Steps Practice Data

1. Double-click the icon for the C: drive.
The C: window opens and displays the
contents of the C: drive. Double-click 

2. To view the contents of any folders
that may be on the C: drive, double-
click the folder’s icon.
The folder opens and a window
displays folders and files within that
folder.

Double-click the

 folder

Close all open windows except the My Computer window.

VIEWING A DISKETTE

! Discussion

My Computer provides access to all of your computer’s resources, including available
diskette drives. You can use My Computer to access diskettes and view files and
folders.

$ Procedures

1. Double-click the icon representing the diskette drive containing the
diskette you want to view.

% Step-by-Step

Use My Computer to access your diskette drive. First, insert a diskette into your A:
drive. Open the My Computer window, if necessary.
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Steps Practice Data

1. Double-click the icon representing the
diskette drive containing the diskette
you want to view.
The Floppy window opens and
displays folders and files present on
the diskette.

Double-click 

Close the 3 1/2 Floppy window.

STARTING A PROGRAM

! Discussion

My Computer displays all of the resources available to you. You can use My
Computer to access and start program files that may be stored on your computer’s
hard drive, a network drive, or any storage device. This method of starting a program
is ideal if you know where the program file is located, and no icon or shortcut exists
for the program on your desktop.

$ Procedures

1. Double-click the icon representing the drive where the program is
stored.

2. If the program file is not visible, double-click the folder containing
the program.

3. Continue to double-click folders until the program file you want to
run is visible.

4. Double-click the program file you wish to run.

% Step-by-Step

Use My Computer to start a program. Open the My Computer window and switch the
view to large icons, if necessary.
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Steps Practice Data

1. Double-click the icon representing the
drive where the program is stored.
The drive window opens and displays
available folders and files.

Double-click 

2. If the program file is not visible,
double-click the folder containing the
program.
The folder window opens and displays
available folders and files.

Double-click

3. Continue to double-click folders until
the program file you want to run is
visible.
The folder windows open to display
available folders and files.

Double-click

Then double-click

   

4. Double-click the program file you
wish to run.
The program starts.

Double-click 

Close the WordPad program and any open windows.
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EXERCISE

USING MY COMPUTER

# Task

Use My Computer.

1. Open My Computer.

2. View the contents of the C: drive.

3. Open the Winnt folder and view its contents.

4. Change the view in the Winnt folder to Small Icons and then to
Details.

5. Return the view in the folder to its default of Large Icons.

6. Close the Winnt folder, then close the (C:) and the My Computer
windows.





LESSON 9 -
USING FILES/FOLDERS/SHORTCUTS

In this lesson, you will learn how to:

• Create folders

• Rename folders

• Move folders

• Copy folders

• Send folders to diskette

• Create files

• Rename files

• Move files

• Copy files

• Send files to diskette

• Create shortcuts

• Rename shortcuts

• Configure the Recycle Bin

• Delete files

• Retrieve deleted objects

• Empty the Recycle Bin
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CREATING FOLDERS

! Discussion

In Windows NT, directories and subdirectories are represented as folders. When you
create a folder, therefore, you are actually creating a new directory or subdirectory.

Windows NT allows you to create a folder from the desktop using the desktop’s
shortcut menu. Once a folder is created, by default, it is named New Folder. You can,
however, change this name at any time.

Folders can also be created from within any folder or storage device window (for
example, from within the C: drive window of My Computer), as well as from within
the Windows Explorer.

A folder icon

"
In Windows NT, subdirectories are shown as folders while the
files inside directories appear as icons of spreadsheets,
documents, or other objects.

$ Procedures

1. Click the right mouse button on the desktop.

2. Point to New on the shortcut menu.

3. Select Folder.

4. Enter a new title, if desired, by typing a new description.

5. Press [Enter].

% Step-by-Step

Create a folder from the desktop.
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Steps Practice Data

1. Click the right mouse button on the
desktop.
A shortcut menu appears.

Click the right mouse
button on the desktop

2. Point to New on the shortcut menu.
A submenu appears.

Point to New

3. Select Folder.
A folder is created called New Folder.

Click Folder

4. Enter a new title, if desired, by typing
a new description.
A new title is associated with the
folder created.

Type Test Folder

5. Press [Enter].
The new folder is named.

Press [Enter]

RENAMING FOLDERS

! Discussion

You can rename a folder using the shortcut menu associated with the folder.
Renaming a folder changes both the title displayed with the folder as well as the
internal name used by the computer to recognize the folder.

"
You can quickly rename a folder by selecting it, pressing [F2],
and entering a new folder name.

$ Procedures

1. Click the right mouse button on a folder object.

2. Select Rename from the shortcut menu.

3. Enter a new name for the object.

4. Press [Enter].
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% Step-by-Step

Rename the Test Folder object.

Steps Practice Data

1. Click the right mouse button on a
folder object.
A shortcut menu appears.

Click the right mouse

button on 

2. Select Rename from the shortcut
menu.
The current name associated with the
item is selected.

Click Rename

3. Enter a new name for the object.
A new folder name appears for the
item.

Type My Folder

4. Press [Enter].
The folder is renamed.

Press [Enter]

MOVING FOLDERS

! Discussion

You can move a folder using drag and drop. Moving a folder actually moves the
folder to another location; and a copy of the folder does not remain in the original
location.

"
When a folder is moved, all folders and files that reside in it
are moved to the target destination as well.

$ Procedures

1. Drag the item to be moved to a target destination.

2. Release the mouse button.
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% Step-by-Step

Move My Folder to a different location on the desktop.

Steps Practice Data

1. Drag the item to a target destination.
The item moves as you drag.

Drag  to a
location on the desktop

2. Release the mouse button.
The item moves to the target
destination.

Release the mouse button

COPYING FOLDERS

! Discussion

You can copy folders using drag and drop. When a folder is copied, all folders and
files that reside in it are also copied to the target destination.

"
If you want to copy more than one item, hold the [Ctrl] key
while clicking the items to be copied.

$ Procedures

1. Press [Ctrl] and drag the item to be copied to a destination location.

2. Release the mouse button and then [Ctrl].

% Step-by-Step

Copy My Folder.
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Steps Practice Data

1. Press [Ctrl] and drag the item to be
copied to a destination location.
The item moves as you drag.

Press [Ctrl] and drag

 to a location on
the desktop

2. Release the mouse button and then
[Ctrl].
The item is copied to the destination
location.

Release the mouse button
and then [Ctrl]

Delete Copy of My Folder from the desktop by selecting it, pressing [Delete], and
selecting Yes.

SENDING FOLDERS TO DISKETTE

! Discussion

You can quickly send folders to a diskette by using the Send To command from an
object’s shortcut menu.

$ Procedures

1. Click the right mouse button on a folder.

2. Point to Send To on the shortcut menu.

3. Select 3 1/2 Floppy.

% Step-by-Step

To send a folder to a diskette, insert a diskette in the diskette drive.
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Steps Practice Data

1. Click the right mouse button on a
folder.
A shortcut menu appears.

Click the right mouse

button on 

2. Point to Send To on the shortcut
menu.
A submenu appears.

Point to  Send To

3. Select 3 1/2 Floppy.
The folder is copied to the diskette.

Click 3 1/2 Floppy (A)

Delete My Folder from the desktop by selecting it, pressing [Delete], and selecting
Yes.

CREATING FILES

! Discussion

In Windows NT, the name of a file can be up to 255 characters in length. For
example, XYZ Company Sales and Analysis is a legitimate filename. This naming
convention is called “using long filenames.”

When files are named in Windows NT or Windows NT-based software, the long
filename is referred to as a primary filename. However, an alias filename is also
automatically generated by Windows NT. The alias filename follows the 8.3 format,
eight characters and a three character extension, allowing files created in Windows
NT to be used in older applications that do not recognize or support long filenames.
When you use files with long filenames on another system that does not support long
filenames, only the alias filenames are visible.

Long filenames can include the following additional characters not supported by the
8.3 format: plus (+), comma (,), semicolon (;), equal sign (=), brackets ([ ]), and
spaces. Illegal characters include \, /, :, ?, “, <, >, and |.

$ Procedures

1. Click the right mouse button on the desktop.

2. Point to New on the shortcut menu.

3. Select Text Document.
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4. Enter a new title for the file, if desired.

5. Press [Enter].

% Step-by-Step

Create a text file from the desktop.

Steps Practice Data

1. Click the right mouse button on the
desktop.
A shortcut menu appears.

Click the right mouse
button on the desktop

2. Point to New on the shortcut menu.
A submenu appears.

Point to New

3. Select Text Document.
A text file is created named New Text
Document.

Click Text Document

4. Enter a new title, if desired.
A new title is associated with the text
document created.

Type My Text Document

5. Press [Enter].
The new title is entered.

Press [Enter]

RENAMING FILES

! Discussion

You can rename a file using the shortcut menu associated with the file.

"
You can quickly rename a file by selecting it, pressing [F2],
and entering a new filename.
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$ Procedures

1. Click the right mouse button on the file object.

2. Select Rename on the shortcut menu.

3. Enter a new name for the file.

4. Press [Enter].

% Step-by-Step

Rename the My Text Document object.

Steps Practice Data

1. Click the right mouse button on the
file object.
A shortcut menu appears.

Click the right mouse

button on 

2. Select Rename on the shortcut menu.
The current name associated with the
file is selected.

Click Rename

3. Enter a new name for the file.
A new filename appears for the item.

Type My Fax Document

4. Press [Enter].
The file is renamed.

Press [Enter]

MOVING FILES

! Discussion

You can move a file using drag and drop. Moving a file actually moves the file to
another location; and a copy of the file does not remain in the original file location.
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$ Procedures

1. Drag the item to be moved a target destination.

2. Release the mouse button.

% Step-by-Step

Move the My Fax Document file.

Steps Practice Data

1. Drag the item to be moved to a target
destination.
The item moves as you drag.

Drag  to a
location on the desktop

2. Release the mouse button.
The item is moved to the target
destination.

Release the mouse button

COPYING FILES

! Discussion

Windows NT allows you to copy files using drag and drop.

"
If you want to copy more than one item, hold the [Ctrl] key
while clicking the items to be copied.

$ Procedures

1. Press [Ctrl and drag the item to be copied to a destination location.

2. Release the mouse button and then [Ctrl].
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% Step-by-Step

Copy the My Fax Document file.

Steps Practice Data

1. Press [Ctrl] and drag the item to be
copied to a destination location.
The item moves as you drag.

Press [Ctrl] and drag

 to a location on
the desktop

2. Release the mouse button and then
[Ctrl].
The item is copied to the destination
location.

Release the mouse button
and then [Ctrl]

Delete Copy of My Fax Document from the desktop by selecting it, pressing
[Delete], and selecting Yes.

SENDING FILES TO DISKETTE

! Discussion

You can quickly send files to a diskette by using the Send To command from the
shortcut menu.

$ Procedures

1. Click the right mouse button on a file.

2. Point to Send To on the shortcut menu.

3. Select 3 1/2 Floppy.

% Step-by-Step

To send a file to a diskette, insert a diskette in the diskette drive.
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Steps Practice Data

1. Click the right mouse button on a file.
A shortcut menu appears.

Click the right mouse

button on 

2. Point to Send To on the shortcut
menu.
A submenu appears.

Point to  Send To

3. Select 3 1/2 Floppy or 5 1/4 Floppy.
The file is copied to the diskette.

Click 3 1/2 Floppy (A)

Delete My Fax Document from the desktop by selecting it, pressing [Delete], and
selecting Yes.

CREATING SHORTCUTS

! Discussion

A shortcut is a pointer to an application or document that contains information about
the object to which it points. By double-clicking a shortcut icon, whatever object the
shortcut points to is immediately launched. Shortcuts can be created to access any
object, including folders, disk drives, printers, or other computers. In addition, once a
shortcut is created, you can move it to another folder or to the desktop.

A shortcut icon

"
Shortcuts provide quick access to the documents and
applications you use most often.

"
Shortcut icons have an arrow icon in their bottom-left corner.
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$ Procedures

1. Open My Computer.

2. Double-click the icon for the drive containing the object to which
you want to make a shortcut.

3. Hold the right mouse button on the object and drag it to the desktop.

4. Release the mouse button.

5. Select Create Shortcut on the shortcut menu.

% Step-by-Step

Create a shortcut.

Steps Practice Data

1. Open My Computer.
The My Computer window opens.

Double-click 

2. Double-click the icon for the drive
containing the object to which you
want to make a shortcut.
The drive’s window opens.

Double-click the drive
containing the Student
Data Folder

3. Hold the right mouse button on the
object and drag it to the desktop.
The object moves as you drag.

Hold the right mouse

button  and
drag it to the desktop

4. Release the mouse button.
A shortcut menu appears.

Release the mouse button

5. Select Create Shortcut on the
shortcut menu.
A shortcut to the object is created.

Click Create
Shortcut(s) Here

Close all open windows. Test the shortcut by double-clicking it. Notice that you no
longer need to access My Computer to view the Student Data Folder. Close all open
windows.
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RENAMING SHORTCUTS

! Discussion

You can rename a shortcut using the shortcut menu associated with it.

"
You can quickly rename a shortcut by selecting it, pressing
[F2], and entering a new shortcut name.

$ Procedures

1. Click the right mouse button on a shortcut.

2. Select Rename on the shortcut menu.

3. Enter a new name for the shortcut.

4. Press [Enter].

% Step-by-Step

Rename a shortcut.

Steps Practice Data

1. Click the right mouse button on a
shortcut.
A shortcut menu appears.

Click the right mouse

button on 

2. Select Rename on the shortcut menu.
The current name associated with the
item is selected.

Click Rename

3. Enter a new name for the shortcut.
A new shortcut name appears for the
item.

Type Shortcut to
Windows NT Folder
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Steps Practice Data

4. Press [Enter].
The shortcut is renamed.

Press [Enter]

CONFIGURING THE RECYCLE BIN

! Discussion

You can specify the size of the Recycle Bin for each hard drive on the computer. Each
drive can be configured separately or a global setting can be made to apply to all the
hard drives. In addition, the Recycle Bin can be configured so that the files are deleted
from the disk immediately and never stored in the Recycle Bin.

By default, 10 percent of your hard disk is reserved to store files in the Recycle Bin.
You can increase or decrease the Recycle Bin storage limit to correspond to individual
working preferences.  You can designate what percentage of the hard drive you want
to use to store deleted files.  After the storage limit is reached, files are moved from
the Recycle Bin according to date.  For example, if you delete a file after the storage
limit is reached, the deleted file replaces the oldest file in the Recycle Bin.

"
If you would rather permanently delete files directly from your
storage devices, without sending them to the Recycle Bin, you
can check the Do not move files to the Recycle Bin. Remove
files immediately on delete option.

$ Procedures

1. Click the right mouse button on the Recycle Bin.

2. Select Properties.

3. Select the Use one setting for all drives or Configure drives
independently option.

4. Drag the slider to indicate the percentage of the drive you want to
use for the Recycle Bin.

5. Release the mouse button.

6. Select OK.



Lesson 9 - Using Files/Folders/Shortcuts Windows NT Basics

Page 92 University Technology Training Center

DELETING FILES

! Discussion

When you delete a file in Windows NT, it is not deleted instantly. Rather, it is placed
into the Recycle Bin. The Recycle Bin, which is located on the desktop, is a storage
area used to hold deleted objects. Although no longer visible on your desktop, deleted
objects are not actually deleted from drives or directories until you empty the Recycle
Bin.

The Recycle Bin provides quick access to information about deleted objects, including
original location, date of deletion, and file type and size. Most importantly, the
Recycle Bin provides the ability to restore deleted objects to their original disk
location.

Deleted files in the Recycle Bin

"
When deleting shortcuts, you are deleting just the icon, not the
file or application associated with it.

"
If you use the [Delete] key or the Delete command on the
shortcut menu, Windows NT prompts you with a dialog box to
confirm the deletion.

&
Files dragged to the Recycle Bin from floppies do not appear
in the Recycle Bin. They are deleted directly from the
floppies.

$ Procedures

1. Drag the item to be deleted to the Recycle Bin located on the
desktop.

2. Release the mouse button.
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% Step-by-Step

Delete the Shortcut to Windows NT Folder object using the Recycle Bin.

Steps Practice Data

1. Drag the item to be deleted to the
Recycle Bin located on the desktop.
The item is deleted to the Recycle Bin.

Drag  to the
Recycle Bin on the
desktop

2. Release the mouse button.
The item is deleted to the Recycle Bin.

Release the mouse button

Close all open windows.

RETRIEVING DELETED OBJECTS

! Discussion

You can retrieve a deleted file or folder from the Recycle Bin. When an object is
retrieved from the Recycle Bin using the Restore command, it is automatically
returned to the disk location from which it was initially deleted. If you click on a file
and drag it to a new location it will be stored in that location.

"
To retrieve more than one object from the Recycle Bin, press
and hold the [Ctrl] key while clicking each object to be
retrieved. Then, select the Restore command from the File
pull-down menu.

$ Procedures

1. Double-click the Recycle Bin icon.

2. Select the object you want to retrieve from the Recycle Bin.

3. Select the File pull-down menu.

4. Select Restore.
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% Step-by-Step

Retrieve the Shortcut to Windows NT Folder object from the Recycle Bin.

Steps Practice Data

1. Double-click the Recycle Bin icon.
The Recycle Bin window opens.

Double-click 

2. Select the object you want to retrieve
from the Recycle Bin.
The file is selected.

Click Shortcut to
Window...

3. Select the File pull-down menu.
The File pull-down menu appears.

Click File

4. Select Restore.
The object is retrieved from the
Recycle Bin and returned to its
original location.

Click Restore

Close the Recycle Bin and delete the Shortcut to Windows NT Folder.

EMPTYING THE RECYCLE BIN

! Discussion

The Recycle Bin is a storage area used to hold objects that were previously deleted.
To permanently remove all the objects in the Recycle Bin and, therefore, remove all
deleted objects from a drive, you must empty the Recycle Bin. The Recycle Bin
should be periodically emptied to maintain hard disk space.

$ Procedures

1. Double-click the Recycle Bin icon.

2. Select the File pull-down menu.

3. Select Empty Recycle Bin.

4. Confirm that you want to delete the items in the Recycle Bin.
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% Step-by-Step

Empty the Recycle Bin.

Steps Practice Data

1. Double-click the Recycle Bin icon.
The Recycle Bin window opens.

Double-click 

2. Select the File pull-down menu.
The File pull-down menu appears.

Click File

3. Select Empty Recycle Bin.
A confirmation dialog box opens.

Click Empty Recycle
Bin

4. Confirm that you want to delete the
items in the Recycle Bin.
The items are removed  from the
Recycle Bin and deleted from disk.

Click Yes

Close the Recycle Bin and any other open windows.
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EXERCISE

USING FILES, FOLDERS, AND SHORTCUTS

# Task

Manipulating files, folders, and shortcuts in Windows NT.

1. Create a new folder in the Student Data Folder and name it Exercise.

2. Copy the Fax file from the Memos Sent folder in the Student Data
Folder to the Exercise folder.

3. Create a shortcut to the Exercise folder on your desktop.

4. Use the shortcut to view the contents of the Exercise folder.

5. Rename the shortcut on the desktop to Shortcut to New Exercise.

6. Insert a diskette into the A: drive of your computer and send the Fax
file to the diskette.

7. Check the contents of the A: drive. Rename the Fax file on the A:
drive to Copy of Fax.

8. Delete the shortcut from the desktop.

9. Open the Recycle Bin. Locate the Shortcut to New Exercise object
and retrieve it from the Recycle Bin back to the desktop.

10. Delete the shortcut again. Then, empty the Recycle Bin.

11. Close all open windows.



LESSON 10 -
USING HELP

In this lesson, you will learn how to:

• Use Help

• Use the Contents sheet

• Use the Index sheet

• Use the Find sheet

• Access Help in a dialog box

• Copy text from a help topic

• Change help topic fonts

• Print a help topic
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USING HELP

! Discussion

Using the on-line Help facility in Windows NT, you can access a help topic with the
Contents, Index, or Find sheet in a help window. Help topics may have any or all of
the following elements: shortcuts, related topics, and underlined words. Clicking a
shortcut, represented by an arrow, takes you into Windows NT to perform a task;
clicking a related task takes you to another help topic; and clicking an underlined
word displays a pop-up definition of the word.

USING THE CONTENTS SHEET

! Discussion

The Help Contents sheet lists the main topics in the Help facility. Each topic is
preceded by a book icon. If you double-click the book icon, the icon changes to an
open book and the subtopics display. A subtopic that has a book icon also has
additional subtopics. A subtopic that is represented by a page with a question mark
displays a help topic when double-clicked.
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The Contents sheet

$ Procedures

1. Click Start.

2. Select Help.

3. Select the Contents tab if the Contents sheet is not displayed.

4. Double-click a topic to open it.

5. Continue double-clicking topics until the desired topic appears.

6. Double-click a topic to display it.

% Step-by-Step

Display the Help Contents sheet and select a topic for viewing.
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Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Select Help.
The Help window opens. Click  Help

3. Select the Contents tab, if necessary.
The Contents sheet appears.

Click Contents, if
necessary

4. Double-click a topic to open it.
The topic expands, displaying
subtopics.

Double-click How To...

5. Continue double-clicking topics until
the desired topic appears.
The topics expand until the desired
topic appears.

Double-click Use Help

6. Double-click a topic to display it.
A help window opens displaying help
for the desired topic.

Double-click Finding a
topic in Help

Close the help window.

USING THE INDEX SHEET

! Discussion

The Windows NT Help Index works like the Windows 3.1 Help Index. The Index
sheet lists topics alphabetically, like the index of a book. You can scroll the list with
the scroll bars or type the first few letters of the word you want to find.
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The Index sheet

$ Procedures

1. Click Start.

2. Select Help.

3. Select the Index tab, if necessary.

4. Scroll the list of options or type the first few letters of the topic until
the topic is visible in the box.

5. Double-click the topic to display it.

6. If additional topics display, double-click to display them.

% Step-by-Step

Use the Help Index sheet to find a topic.
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Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Select Help.
The Help window opens. Click  Help

3. Select the Index tab, if necessary.
The Index sheet appears.

Click Index, if necessary

4. Scroll the list of options or type the
first few letters of the topic until the
topic is visible in the box.
The list scrolls to the desired topics.

Type add

5. Double-click the topic to display it.
A help window opens displaying help
for the topic or additional topics
available.

Double-click adding

6. If additional topics display, double-
click to display them.
A help window opens displaying help
for the topic or additional topics
available.

Double-click To create a
new folder

Close the help window.

USING THE FIND SHEET

! Discussion

The Find sheet of the Help facility looks for a specified string by searching a database
of words and phrases found in help topics. Options on the Find sheet allow you to
search in different ways. For example, you can search for all the words you type in
any order or in the exact order, or you can search for at least one of the words you
type. You can also specify whether you want to look for the specified string as the
beginning of a string, as any part of a string, or as the end of a string. You also can
search for words that have the same root. For example, if you search for “add,” topics
include “add,” “adding,” “added,” “additional,” etc.

The Windows NT Help Find sheet replaces the Search feature used in the Windows
3.1 Help system.
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The Find sheet

"
You can customize a find by selecting the Options command
button and choosing specific options to be used during the
find.

$ Procedures

1. Click Start.

2. Select Help.

3. Select the Find tab, if necessary.

4. Enter the string you want to find.

5. If necessary, scroll though the list of topics and double-click the one
you want.
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% Step-by-Step

Use the Find sheet to search for words or phrases in help topics.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Select Help.
The Help window opens. Click  Help

3. Select the Find tab, if necessary.
The Find sheet appears.

Click Find, if necessary

4. Enter the string you want to find.
A list of topics displays in the box at
the bottom.

Type printer icon

5. If necessary, scroll though the list of
topics and double-click the one you
want.
A help window opens displaying help
for the topic.

Double-click Changing
your password.

Close the help window.

ACCESSING HELP IN A DIALOG BOX

! Discussion

Almost all Windows NT dialog boxes have the What’s This button in the upper-right
corner. The button resembles a question mark and is used to get context-sensitive help
in the dialog box. Some dialog boxes actually have a Help command button that
displays a help topic about the particular dialog box.

$ Procedures

1. Click the What’s This button.

2. Click any option in the dialog box.

3. Click the mouse again to close the help pop-up box.
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% Step-by-Step

Use the What’s This button in a dialog box to get context-sensitive help. First, open
the System Properties dialog box by pointing to My Computer, clicking the right
mouse button, choosing Properties, and clicking the Performance tab.

Steps Practice Data

1. Click the What’s This button.
The mouse pointer displays with a
question mark.

Click 

2. Click any option in the dialog box.
A pop-up box appears with help
information on the option.

Click Virtual Memory

3. Click the mouse button again to close
the help pop-up box.
The help pop-up box closes.

Click the mouse button

Close the System Properties dialog box.

COPYING TEXT FROM A HELP TOPIC

! Discussion

Text in a help topic can be highlighted and copied to the Clipboard just like text in any
other type of document. You cannot paste the contents of the Clipboard back into a
help topic, but you can paste it into a document.

"
Because you cannot position the insertion point in a help topic,
the only way you can highlight the text you want to copy is to
click and drag.

$ Procedures

1. Drag to select the text you want to copy.

2. Release the mouse button.

3. Select the Options command button.

4. Select Copy.
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% Step-by-Step

Copy information from a help topic to the Clipboard. First, display a help topic.

Steps Practice Data

1. Drag to select the text you want to
copy.
The text is highlighted as you drag.

Drag through a couple of
sentences

2. Release the mouse button.
The text is selected.

Release the mouse button

3. Select the Options command button.
The Options menu appears.

Click Options

4. Select Copy.
The selected text is copied to the
Clipboard.

Click Copy

Close the help window. If you want to verify that the text has been copied, open the
Clipboard Viewer.

CHANGING HELP TOPIC FONTS

! Discussion

The size of the font used in help topics can be changed from Normal (the default), to
Small or Large. If you choose Small, you will be able to see more text in the Help
window, but it will be harder to read. If you choose Large, the text is easier to read,
but less text is visible in the window.

$ Procedures

1. Click Start.

2. Select Help.

3. Select the Contents tab.

4. Select a desired help topic.

5. Select Options.



Windows NT Basics Lesson 10 - Using Help

University Technology Training Center Page 107

6. Point to Font.

7. Select the desired font size.

% Step-by-Step

Change the size of the font used in a help topic. Open a Help window.

Steps Practice Data

1. Select a help topic from any tab.
The help topic appears.

Double-click If you’ve
used Windows before

2. Select Options.
The Options menu appears.

Click Options

3. Point to Font.
A Font submenu appears.

Point to Font

4. Select the desired font size.
The help topic is sized to the option
selected.

Click Large

Reset the font size to Normal and close the Help window.

PRINTING A HELP TOPIC

! Discussion

As in Windows 3.1, you can print Windows NT help topics. Since it is not always
convenient to use Help on-line, it is helpful to be able to print a help topic so you can
refer to it easily. You might even want to print several help topics to which you refer
often and create a help booklet.

$ Procedures

1. Select Options.

2. Select Print Topic.

3. Select desired options in the Print dialog box.

4. Select OK.
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% Step-by-Step

Print a help topic. First, display a help topic.

Steps Practice Data

1. Select Options.
The Options menu appears.

Click Options

2. Select Print Topic.
The Print dialog box opens.

Click Print Topic

3. Select desired options in the Print
dialog box.
The print options are selected.

Accept the defaults

4. Select OK.
Windows NT prints the help topic.

Click OK

Close the help window.
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EXERCISE

USING HELP

# Task

Using Help.

1. Open the Help window and display the Contents sheet.

2. Locate help on how to print a document. View the topic, then close
the window.

3. Open the Help window and display the Index sheet.

4. Use the Index sheet to locate help for deleting a file or folder.

5. View the help topic.

6. Close the help topic window.





LESSON 11 -
USING WINDOWS NT EXPLORER

In this lesson, you will learn how to:

• Use Windows NT Explorer

• View your computer

• Open objects

• Create a folder

• Copy files and folders

• Move files and folders

• Delete files and folders
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USING WINDOWS NT EXPLORER

! Discussion

Windows NT Explorer is a file management tool included with Windows NT. You
can use Explorer to view, copy, and move files and folders; format disks; and perform
other tasks related to file management.

The Explorer window displays two panes, or viewing areas. The left pane displays a
tree that includes objects representing all available resources, including files, folders,
network resources, and peripherals such as printers and modems.

Each object is graphically represented within the tree by an icon. If an object appears
in the tree with a plus symbol (+), it can be expanded to another level within the tree.
If an object appears with a minus symbol (-), then it has been fully expanded to view
all objects within it. If an object has no (+) or (-), then it contains no folders, only files
or nothing at all.

As objects are selected and expanded in the tree, objects that are stored within the
selected object (i.e., files within a selected folder) appear in the right pane of the
Explorer window. In most cases, objects that appear in this pane can be accessed by
double-clicking. The view within this pane can be changed to suit your individual
preferences.

The Windows NT Explorer window
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VIEWING YOUR COMPUTER

! Discussion

Windows NT Explorer is a Windows NT tool that allows you to perform file
management tasks. You can use the Explorer to quickly view the contents of your
computer. This option allows you to determine network drives that are available to
you.

$ Procedures

1. Click the Start button.

2. Point to Programs.

3. Select Windows NT Explorer.

4. To expand an object in the tree, click the (+) next to the object once
or double-click the object’s icon.

5. Continue to expand the tree until the object or folder you wish to
access is visible.

6. To view the contents of a folder, double-click the folder either in the
tree or in the right pane.

7. To collapse an object in the tree, click the (-) next to the object once
or double-click the object’s icon.

% Step-by-Step

Use Explorer to view the contents of your computer, the Student Data Folder, and the
Accounting folder within the Student Data Folder. The Student Data Folder must be
located on a diskette in the A: drive and the Explorer must be set to its default view of
large icons.

Steps Practice Data

1. Click the Start button.
The Start menu appears.

Click  Start

2. Point to Programs.
The Programs submenu appears. Point to  Programs
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Steps Practice Data

3. Select Windows NT Explorer.
The Windows Explorer window opens.

Click  Windows NT
Explorer

4. To expand an object in the tree, click
the (+) next to the object once or
double-click the object’s icon.
The tree expands to display folders
within the object.

Double-click on the icon,
or single-click on the (+)

 31/2 Floppy (A:)

5. Continue to expand the tree until the
object or folder you wish to access is
visible.
The tree expands and the (+) next to
the object changes to a (-).

Double-click on the icon,
or single-click on the (+)

 Student Data
Folder

6. To view the contents of a folder,
double-click the folder either in the
tree or in the right pane.
The contents of the folder are
displayed in the right pane of the
Explorer window.

Double-click 

7. To collapse an object in the tree, click
the (-) next to the object once or
double-click the object’s icon.
The tree collapses and the (-) next to
the object changes to a (+).

Double-click on the icon,
or single-click on the (+)

 Student Data
Folder

OPENING OBJECTS

! Discussion

You can open objects (such as files) and launch programs from within Windows NT
Explorer. When a file is opened from the Explorer, the program that was used to
create the file is automatically launched and the file opens within that program.

If Windows does not recognize the file type when opening an object, it displays a
dialog box prompting you to select a program with which to open the file.

"
You can quickly view the properties of any object (including
files) by clicking the right mouse button on the object and
selecting Properties.
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$ Procedures

1. Expand the tree to view folders within an object in the tree, click the
(+) next to the object once or double-click the object’s icon.

2. Continue to expand the tree by clicking (+) objects until the object or
folder you wish to access is visible.

3. Double-click the object you wish to open in the right pane.

% Step-by-Step

Use the Explorer to open a program file. Open the Explorer, if necessary.

Steps Practice Data

1. Expand the tree to view folders within
an object in the tree, click the (+) next
to the object once or double-click the
object’s icon.
The tree expands to display folders
within the object and the (+) next to
the object changes to a (-).

Double-click on the icon,
or single-click on the (+)

 (C:), if necessary

2. Expand the tree to view the folder’s
subfolders.
The tree expands to display subfolders
within the object and the (+) next to
the object changes to a (-).

Double-click on the icon,
or single-click on the (+)

 Winnt

3. Expand the folder that contains the
desired program icon.
The tree expands to display program
icons within the object and the (+)
next to the object changes to a (-).

Double-click on the icon,
or single-click on the (+)

 System32

4. Double-click the object you wish to
open in the right pane.
The object opens.

Double-click 

Close the MS-Paint program.
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CREATING A FOLDER

! Discussion

You can create a folder in Windows NT Explorer using the same method used to
create folders in any window. By selecting the New command from the File pull-
down menu, the Folders command is available. Selecting these menu commands will
create a folder within the object that is currently selected in the Explorer tree.

"
If you want to view the new folder in the tree, select
View...Refresh to update the contents of the window.
Otherwise, the new folder will not appear in the tree until you
close the window and reopen it.

$ Procedures

1. Select the drive or folder in the tree in which you want to create the
new folder.

2. Select the File pull-down menu.

3. Point to New.

4. Select Folder.

5. Enter a name for the folder.

6. Press [Enter].

% Step-by-Step

Use Explorer to create a new folder on the C: drive called My New Folder. Open the
Explorer, if necessary.
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Steps Practice Data

1. Select the drive or folder in the tree in
which you want to create the new
folder.
The drive or folder is selected and will
be displayed on the right side.

Click  (C:)

2. Select the File pull-down menu.
The File pull-down menu appears.

Click File

3. Point to New.
The New submenu appears.

Point to New

4. Select Folder.
A new folder appears in the right pane
of the Explorer window. The default
folder name is selected, allowing you
to rename it.

Click Folder

5. Enter a name for the folder.
The folder name appears next to the
new folder in the right pane of the
Explorer window.

Type My New Folder

6. Press [Enter].
The new folder name is entered.

Press [Enter]

COPYING FILES AND FOLDERS

! Discussion

As a file management tool, Windows NT Explorer allows you to copy files and
folders to different locations on your hard drive, to a network drive, or to diskette.

You can copy folders directly to and from locations in the tree or from the right pane
of the Explorer window to the desired location in the tree. However, since files do not
appear in the tree, they can only be copied from the right pane.

There are a number of different ways to copy files and folders in Explorer. You can
use the shortcut menu, the Edit pull-down menu, or drag and drop. Using drag and
drop to copy files is similar to moving files. To be sure that you are copying instead of
moving, make sure that a plus (+) symbol appears when you are dragging the file or
folder.
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"
When copying files and folders to other drives, it is not
necessary to hold [Ctrl]. However, when copying to other
locations on the same drive, you must hold [Ctrl]. You can
also copy multiple files and folders to a location by selecting
multiple files and folders, holding [Ctrl], and dragging to the
destination of the copy.

$ Procedures

1. Double-click folders in the tree until the files or folders you wish to
copy are visible either in the tree or the right pane.

2. Drag the file or folder you want to copy to the desired location on the
tree.

3. Release the mouse button.

% Step-by-Step

Use Explorer to copy files. Insert the diskette with the Student Data Folder into the A:
drive and open the Explorer, if necessary.

Steps Practice Data

1. Double-click folders in the tree until
the files or folders you wish to copy
are visible either in the tree or the right
pane.
The tree expands and the folder’s
contents appear in the right pane.

Double-click on the icon,
or single-click on the (+)

 31/2 Floppy (A:)

2. Drag the file or folder you want to
copy to the desired location on the
tree.
The file or folder moves as you drag.

Drag  to

 My New Folder

3. Release the mouse button.
The file or folder is copied to the new
location.

Release the mouse button
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MOVING FILES AND FOLDERS

! Discussion

Windows NT Explorer is a useful tool for moving files and folders to different
locations on your hard drive, to a network drive, or to diskette.

You can move folders directly to and from locations in the tree or from the right pane
of the Explorer window to the desired location in the tree. However, since files do not
appear in the tree, they can only be moved from the right pane.

There are a number of different ways to move files or folders in Explorer. You can use
the shortcut menu, the Edit pull-down menu, or drag and drop. Using drag and drop to
move files is very similar to copying files. To be sure that you are moving instead of
copying, make sure that the plus (+) symbol is not present when you are dragging the
file or folder.

"
When moving files or folders to a different location on the
same drive, it is not necessary to hold [Shift]. You can move
multiple files or folders to a location by selecting multiple
folders and files, holding [Shift], and dragging to the new
location.

$ Procedures

1. Double-click the applicable drive icon to expand the tree.

2. Double-click folders in the tree until the files or folders you wish to
move are visible either in the tree or the right pane.

3. Press [Shift] and drag the file or folder to the desired location on the
tree.

4. Release the mouse button and then release [Shift].

% Step-by-Step

Use Explorer to move files. Insert the diskette with the Student Data Folder into the
A: drive and open the Explorer, if necessary.
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Steps Practice Data

1. Double-click the applicable drive icon
to expand the tree.
The tree expands and the drive’s
contents appear in the right pane.

Double-click on the icon,
or single-click on the (+)

 31/2 Floppy (A:)

2. Double-click folders in the tree until
the files or folders you wish to move
are visible either in the tree or the right
pane.
The tree expands and the folder’s
contents appear in the right pane.

Double click

3. Press [Shift] and drag the file or folder
to the desired location on the tree.
The file or folder moves as you drag.

Press [Shift] and drag the

to  My New Folder

4. Release the mouse button and then
release [Shift].
The file or folder moves to the new
location.

Release the mouse button
and then release [Shift]

DELETING FILES AND FOLDERS

! Discussion

As a file management tool, Windows NT Explorer allows you to delete files and
folders from different locations on your hard drive, from a network drive, or from
diskette.

$ Procedures

1. Select the file or folder to be deleted.

2. Press [Delete].

3. Select Yes.
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% Step-by-Step

Use Explorer to delete a folder. Open Explorer and expand the C: drive, if necessary.

Steps Practice Data

1. Select the file or folder to be deleted.
The file or folder is selected.

Click  My New
Folder

2. Press [Delete].
Windows NT displays a dialog box
asking you to confirm the deletion.

Press [Delete]

3. Select Yes.
The file or folder is deleted to the
Recycle Bin.

Click Yes

Close the Explorer window.
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EXERCISE

USING WINDOWS NT EXPLORER

# Task

Use Windows NT Explorer.

1. Open Windows NT Explorer.

2. View the contents of the C: drive of your computer.

3. Create a new folder on the C: drive called Exercise Folder.

4. Insert the diskette with the Student Data Folder into the A: drive.

5. Use Explorer to view the contents of the diskette in the A: drive.

6. Locate the Accounting folder on the diskette.

7. Copy the Accounting folder to the Exercise Folder on the C: drive.

8. Use Explorer to delete the Exercise Folder from the C: drive.

9. Remove the diskette and close Explorer.



LESSON 12 -
VIEWING, OPENING, AND FINDING

In this lesson, you will learn how to:

• Use Quick View

• Find folders/files by name

• Clear a search

• Find folders/files by date

• Perform advanced searches
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USING QUICK VIEW

! Discussion

Windows NT includes a tool called Quick View, which allows you to view the
contents of files created in other Windows applications. If Windows NT recognizes
the selected file as a file created in a Windows application, the Quick View command
appears on the File pull-down menu.

When the Quick View command is selected, the Quick View window opens. In this
window, you can view a file’s contents. This window is useful for viewing the
contents of a file quickly without opening its parent application. In addition, you can
adjust the display font size or open the parent application from within the Quick View
window.

The Quick View window
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"
If Windows NT does not recognize the selected file as a file
created in a Windows application, the Quick View command
will not appear on the File pull-down menu. However, an
Open With command will appear, allowing you to select a
program in which to open and view the file.

$ Procedures

1. Select the file you want to view.

2. Select the File pull-down menu.

3. Select Quick View.

% Step-by-Step

Use Quick View to view a file. Use My Computer to open My Folder in the Student
Data Folder.

Steps Practice Data

1. Select the file you want to view.
The file is selected.

Click 

2. Select the File pull-down menu.
The File pull-down menu appears.

Click File

3. Select Quick View.
The Quick View window opens,
displaying the contents of the selected
file.

Click Quick View

Close all open windows.
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FINDING FOLDERS/FILES BY NAME

! Discussion

Windows NT includes many ways to find files and folders. Although you can use the
Windows Explorer or My Computer to browse folders until you locate a desired folder
or file, Windows NT includes the Find command. This command allows you to
quickly locate files and folders stored on your computer or any network to which your
computer may be attached.

The Find command, located on the Start menu, displays the Find submenu from
which you can select objects for which you want to search. Selecting the Files or
Folders command opens the Find dialog box. The Name & Location property sheet
in this dialog box allows you to specify the filename and location where you want
Windows NT to search.

When performing a search, wildcards such as asterisks (*) can be used. For example,
if you want to search the C: drive for a file named MYFILE.EXE, you would specify
the C: drive as the location and enter MY*.EXE as the filename. The search would
find all .EXE files with names beginning with the characters MY. If a file extension is
not included, Windows NT finds all files containing the valid filename regardless of
the extension (e.g., MYFILE.INI, MYFILE.EXE, MYFILE.COM).

The Name & Location property sheet

"
The Find command is also located on the Tools pull-down
menu in the Explorer window and allows you to perform a
find from within the Explorer. You can also click the right
mouse button on the Start button and select Find.

"
The number of files found appears in the status bar.



Windows NT Basics Lesson 12 - Viewing, Opening, and Finding

University Technology Training Center Page 127

$ Procedures

1. Click Start.

2. Point to Find.

3. Select Files or Folders.

4. Type the name of the file or folder you want to find.

5. Select the Look in arrow.

6. Select the drive you want to search.

7. Check the Include subfolders option to search all folders and
subfolders on the selected drive.

8. Select Find Now to perform the search.

% Step-by-Step

Use the Find command to locate a file.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Find.
The Find submenu appears. Point to  Find

3. Select Files or Folders.
The Find dialog box opens. Click  Files or

Folders...

4. Type the name of the file or folder you
want to find.
The name appears in the Named box.

Type WordPad

5. Select the Look in arrow.
The Look in list appears.

Click Look in 

6. Select the drive you want to search.
The drive appears in the Look in box.

Click  (C:)

7. Check the Include subfolders option
to search all folders and subfolders on
the selected drive.
The option is checked.

Check  Include
subfolders, if necessary
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Steps Practice Data

8. Select Find Now to perform the
search.
The results of the search appear in a
window at the bottom of the Find
dialog box.

Click Find Now

CLEARING A SEARCH

! Discussion

If you want to use the Find command for more than one search, you should clear the
criteria in between searches. Clicking the New Search command button opens a
dialog box that asks you to verify the clearing of the results from your last search.
Once these results are cleared, you can begin a new search.

$ Procedures

1. Select New Search.

2. Select OK.

% Step-by-Step

Clear the results of your last search.

Steps Practice Data

1. Select New Search.
A dialog box opens asking you to
verify the clearing of the results from
your last search.

Click New Search

2. Select OK.
The results of your last search are
cleared.

Click OK
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FINDING FOLDERS/FILES BY DATE

! Discussion

The Find command, available from the Start menu or from the Tools pull-down
menu, opens the Find dialog box. In this dialog box, the Date Modified property sheet
allows you to search for files and folders by date created or date last modified.

Specifically, the Date Modified property sheet allows you to select different date
ranges by which to search. For example, you can find all files that were created or
modified between a specific time period or during a specific number of previous
months or days.

The Date Modified property sheet

"
The number of files found appears in the status bar.

$ Procedures

1. Click Start.

2. Point to Find.

3. Select Files or Folders.

4. Select the Date Modified tab.

5. Select the Find all files created or modified option.
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6. To search for files created or modified within a range of dates, select
the between option.

7. Select the date in the first between box.

8. Type the starting date of the range to be searched.

9. Select the date in the second between box.

10. Type the ending date of the range to be searched.

11. Select Find Now.

% Step-by-Step

Use the Date Modified property sheet in the Find dialog box to locate all files created
within a specific range of dates. Then, perform a new search to locate all files created
within the last three months. Perform a final search to locate all files created within
the last ten days. Open the Find dialog box, if necessary.

Steps Practice Data

1. Select the Date Modified tab.
The Date Modified property sheet
appears.

Click Date Modified

2. Select the Find all files created or
modified option.
The option is darkened.

Click  Find all files
created or modified

3. To search for files created or modified
within a range of dates, select the
between option.
The option is darkened.

Click  between

4. Select the date in the first between
box.
The text in the box is selected.

Double-click the first
between box

5. Type the starting date of the range to
be searched.
The date appears in the box.

Type 6/1/95

6. Select the date in the second between
box.
The text in the box is selected.

Double-click the second
between box

7. Type the ending date of the range to be
searched.
The date appears in the box.

Type today’s date
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Steps Practice Data

8. Select Find Now.
The results of the search appear in a
window at the bottom of the Find
dialog box.

Click Find Now

Clear the current search criteria.

PERFORMING ADVANCED SEARCHES

! Discussion

The Windows NT Find dialog box includes a property sheet that allows you to
perform advanced searches by file type, text content of a file, and file size. You can
use the Advanced property sheet to narrow your search criteria, making your search
faster and more productive when searching numerous files or folders.

You can select a file type as part of your search criteria. The Find dialog box displays
file types in a list. The contents of the list vary depending on what application
software you have installed under Windows. Windows NT searches only files of the
selected type. The Containing text box allows you to specify the text contained in a
file. Windows NT searches the contents of every file matching the selected file type to
locate the file containing the text. Additionally, you can select parameters for file size.
Windows NT only searches files that fall within the size parameters you specify. Only
files that match all three criteria: file type, containing text, and file size appear in a
window at the bottom of the dialog box as a result of the search.

The Advanced property sheet
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"
The number of files found appears in the status bar.

$ Procedures

1. Click Start.

2. Point to Find.

3. Select Files or Folders.

4. Select the Advanced tab.

5. Select the Of type arrow.

6. Scroll as necessary and select the file type for which you want to
search from the list.

7. Select the Containing text box if you want to include specific text
within a file as part of your search criteria.

8. Type the text for which you want to search.

9. Select the Size is arrow if you want to include file size in your search
criteria.

10. Select either At least or At most.

11. Select the KB box.

12. Type the file size criteria.

13. Select Find Now.

% Step-by-Step

Use the Advanced property sheet in the Find dialog box to specify file type, file size,
and containing text to locate a file on the C: drive. Open the File dialog box, if
necessary. Clear any current searches.

Steps Practice Data

1. Select the Advanced tab.
The Advanced property sheet appears.

Click Advanced

2. Select the Of type arrow.
A list of file types appears.

Click Of type 
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Steps Practice Data

3. Scroll as necessary and select the file
type for which you want to search
from the list.
The selected file type appears in the Of
type box.

Scroll as necessary and
click Help File

4. Select the Containing text box if you
want to include specific text within a
file as part of your search criteria.
The insertion point appears in the box.

Click in the Containing
text box

5. Type the text for which you want to
search.
The text appears in the box.

Type local area network

6. Select the Size is arrow if you want to
include file size in your search criteria.
The Size is list appears.

Click Size is 

7. Select either At least or At most.
Your selection appears in the box.

Click At most

8. Select the KB box.
The insertion point is positioned in the
box.

Click in the KB box

9. Type the file size criteria.
The file size appears in the box.

Type 100

10. Select Find Now.
The results of the search appear in a
window at the bottom of the Find
dialog box.

Click Find Now

Close the Find dialog box.
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EXERCISE

VIEWING, OPENING, AND FINDING

# Task

View, open, and find programs, folders, files, and text. Open the Memos Sent folder
from the Student Data Folder, maximize the folder window, and enable the Auto
Arrange command before proceeding.

1. Use Quick View to view the contents of the Hours Worked file.
Close Quick View.

2. Use the Find command to locate the mspaint file on your C: drive.

3. Use the Find command to perform a new search and locate all files
on your C: drive created between 5/25/95 and the current date.

4. Finally, perform a new search to locate all files on your C: drive that
include the text troubleshooting.

Close the Find dialog box and any open windows when finished.



LESSON 13 -
USING STARTUP AND SHUTDOWN

In this lesson, you will learn how to:

• Start Windows NT

• Close the Welcome dialog box

• Shut down - Start menu

• Restart the computer

• Restart with the Start menu

• Shut down - keyboard

• Log Off from Windows NT
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STARTING WINDOWS NT

! Discussion

Windows NT is a complete operating system that starts automatically when you turn
on your computer. Unlike Windows 3.1, Windows NT does not require MS-DOS.

"
If you restart your computer and find yourself at the DOS
prompt, you can start Windows NT by typing WIN and
pressing [Enter].

CLOSING THE WELCOME DIALOG BOX

! Discussion

When starting Windows NT for the first time, the Welcome to Windows NT dialog
box automatically appears. This dialog box will continue to appear every time you
start your system unless you uncheck the Show this Welcome Screen next time you
start Windows option. The dialog box displays user tips and allows you to access the
Windows Tour, What’s New, Online Registration, and Product Catalog features.

If the dialog box appears when you start your computer, you can close it.

$ Procedures

1. Select Close.

% Step-by-Step

Close the Welcome to Windows NT dialog box.
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Steps Practice Data

1. Select Close.
The dialog box closes.

Click Close

SHUTTING DOWN - START MENU

! Discussion

Before turning off your computer, you should follow the Windows NT shut down
procedure found on the Start menu. Shutting down your computer properly will help
you to avoid corrupting system and data files.

"
Once you receive the message that you can safely turn off
your computer, you can turn off the power switch.

$ Procedures

1. Click the Start button.

2. Select Shut Down.

3. Select the Shut down the computer? option.

4. Select Yes.

% Step-by-Step

Use the Start menu to safely shut down your computer.

Steps Practice Data

1. Click the Start button.
The Start menu appears.

Click  Start

2. Select Shut Down.
The Shut Down Windows dialog box
opens.

Click  Shut Down
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Steps Practice Data

3. Select the Shut down the computer?
option.
The option button is darkened.

Click  Shut down the
computer?

4. Select Yes.
Windows NT closes and notifies you
that you can safely turn off your
computer.

Click Yes

RESTARTING THE COMPUTER

! Discussion

Once you have performed the Shut Down procedure, you can use the keyboard to
restart your computer. This option is helpful when you have shut down your computer
and realize you want to return quickly to Windows.

$ Procedures

1. Press [Ctrl+Alt+Delete].

% Step-by-Step

Restart your computer using the keyboard.

Steps Practice Data

1. Press [Ctrl+Alt+Delete].
The computer restarts.

Press [Ctrl+Alt+Delete]



Windows NT Basics Lesson 13 - Using Startup and Shutdown

University Technology Training Center Page 139

RESTARTING WITH THE START MENU

! Discussion

You may need to restart your computer if the system experiences operational
problems. This procedure can be performed by using the Start menu to launch the
Shut Down command, which includes an option for restarting the computer.

$ Procedures

1. Click the Start button.

2. Select Shut Down.

3. Select the Restart the Computer? option.

4. Select Yes.

% Step-by-Step

Restart your computer using the Start menu.

Steps Practice Data

1. Click the Start button.
The Start menu appears.

Click  Start

2. Select Shut Down.
The Shut Down dialog box opens. Click  Shut Down

3. Select the Restart the Computer?
option.
The option button is darkened.

Click  Restart the
Computer?

4. Select Yes.
Windows NT restarts your computer.

Click Yes
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SHUTTING DOWN - KEYBOARD

! Discussion

You can use your keyboard to safely shut down your computer in Windows NT.
Using the keyboard to access the Close Program dialog box provides an alternative to
using the Start menu to shut down your computer.

"
Once you receive the message that you can safely turn off
your computer, you can turn off the power switch.

$ Procedures

1. Press [Ctrl+Alt+Delete].

2. Select Shut Down.

% Step-by-Step

Use the keyboard to shut down your computer.

Steps Practice Data

1. Press [Ctrl+Alt+Delete].
The Close Program dialog box opens.

Press [Ctrl+Alt+Delete]

2. Select Shut Down.
Windows NT closes and notifies you
that you can safely turn off your
computer.

Click Shut Down

Restart the computer by pressing [Ctrl+Alt+Delete].



Windows NT Basics Lesson 13 - Using Startup and Shutdown

University Technology Training Center Page 141

LOGGING OFF FROM WINDOWS NT

! Discussion

To control access to the computer, Windows NT requires all users to log on to the
computer at startup.  If you wish to log out so that someone else can use the computer,
Windows NT also has a logoff feature.

$ Procedures

1. Click the Start button.

2. Select Shut Down.

3. Select the Close All Programs and Log In as Another User?
option.

4. Select Yes.

% Step-by-Step

Logging Off from Windows NT

Steps Practice Data

1. Click the Start button.
The Start menu appears.

Click  Start

2. Select Shut Down.
The Shut Down Windows dialog box
opens.

Click  Shut Down

3. Select the Close All Programs and
Log In as Another User? option.
The option button is darkened.

Click  Close All
Programs and Log In
as Another User?

4. Select Yes.
The computer ends all open programs
and returns you to the login screen..

Click Yes
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EXERCISE

STARTING AND SHUTTING DOWN

# Task

Start and shut down Windows NT.

1. Shut down Windows NT using the Start menu, then turn your
computer off.

2. Start your computer.

3. Shut down Windows NT using the keyboard, but do not turn your
computer off.

4. Press [Ctrl+Alt+Delete] to restart your computer.



LESSON 14 -
USING ACCESSORIES

In this lesson, you will learn how to:

• Use the Calculator

• Perform calculations

• Use the Clipboard Viewer

• Use the Notepad

• Save a file in Notepad

• Use Paint

• Use WordPad

• Open a document

• Add and edit text

• Format text

• Save a file
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USING THE CALCULATOR

! Discussion

Windows NT provides the Calculator accessory, which functions in two different
modes. The standard mode can perform addition, subtraction, multiplication, division,
find the square root, convert a fraction to its decimal equivalent, and calculate a
percentage. The scientific mode is capable of many more functions, such as
calculating the common and natural logarithm; calculating a factorial; finding squares
and cubes; raising a number to any power; calculating sine, cosine, and tangent; and
performing statistical calculations such as average, sum, and standard deviation.

The Windows NT Calculator is very similar to the Windows 3.1 Calculator, both in
appearance and function. The Windows NT Calculator, however, is a 32-bit
application, which makes processing faster.

Windows NT also includes the “What’s This?” help facility to assist you in
determining the function of any Calculator button.

The Scientific Calculator

$ Procedures

1. Click Start.

2. Point to Programs.

3. Point to Accessories.
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4. Select Calculator.

5. Select the View pull-down menu.

6. Select Scientific or Standard.

7. Click the right mouse button on a Calculator button.

8. Select What’s This?.

9. Click anywhere when you are finished reading the help information.

% Step-by-Step

Open the Calculator, display the standard or scientific mode, then display “What’s
This?” help information about a Calculator button.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Programs.
The Programs submenu appears. Point to  Programs

3. Point to Accessories.
The Accessories submenu appears.

Point to 
Accessories

4. Select Calculator.
The Calculator opens.

Click  Calculator

5. Select the View pull-down menu.
The View pull-down menu appears.

Click View

6. Select Scientific or Standard.
The other Calculator view appears.

Click the view that is not
displayed

7. Click the right mouse button on a
Calculator button.
The What’s This? command appears.

Click the right mouse
button on a Calculator
button

8. Select What’s This?
Information about the button appears.

Click What’s This?

9. Click anywhere when you are finished
reading the information.
The help information box closes.

Click anywhere when you
are finished reading the
information
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PERFORMING CALCULATIONS

! Discussion

In principle, using the Windows NT Calculator is the same as using a regular
calculator. You can use your mouse or the keyboard to perform calculations.

"
It is not necessary to press [Enter] or type = if you are taking
a square root or percentage or converting a fraction to a
decimal.

$ Procedures

1. Click the number buttons to enter the number or type the number.

2. Select the operation button.

3. Complete the equation.

4. Press [Enter] or type =.

% Step-by-Step

Perform a basic calculation. Open the Calculator, if necessary.

Steps Practice Data

1. Click the number buttons to enter the
number or type the number.
The number appears.

Type 100

2. Select the operation button.
The calculator accepts the selection.

Type +

3. Complete the equation.
The calculator accepts the additional
data.

Type 100

4. Press [Enter] or type =.
The calculation is performed.

Press [Enter]
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Close the Calculator.

USING THE CLIPBOARD VIEWER

! Discussion

Windows NT, like Windows 3.1, is equipped with a Clipboard that allows you to
copy, cut, and paste text, files, and folders between windows, folders, and other files.
When you copy or cut data, it resides in the Clipboard. When you paste data, it is
pasted from the Clipboard. The Clipboard’s contents can be viewed with the
Clipboard Viewer.

The Clipboard Viewer allows you to view the contents of the Clipboard and to save it
as a file or delete it. You can also delete the contents of the Clipboard, which frees
memory.

The Clipboard Viewer

"
To save the contents of the Clipboard as a file, select
File...Save As, specify a filename and location, and select
OK.

To delete the contents of the Clipboard, select Edit...Delete
and select Yes.

$ Procedures

1. Click Start.

2. Point to Programs.

3. Point to Accessories.

4. Select Clipboard Viewer.
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% Step-by-Step

Copy any file or folder to the Clipboard by clicking its icon with the right mouse
button and selecting Copy.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Programs.
The Programs submenu appears. Point to  Programs

3. Point to Accessories.
The Accessories submenu appears.

Point to 
Accessories

4. Select Clipboard Viewer.
The Clipboard Viewer opens. Click  Clipboard

Viewer

View the contents of the Clipboard, then close the window.

USING THE NOTEPAD

! Discussion

The Notepad is a simple text editing program that does not include many of the word
processing features normally found even in simple word processing programs.
However, it does have margin settings, tabs, page orientation, headers, footers, and a
unique feature that is not found in word processing programs called the log feature.
By entering .LOG (must be capital letters) on the first line of a Notepad file, you
designate the file as a log. Each time you open the file, the date and time are inserted
in the file.
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                                                The Notepad

"
To add text to a document, you can use the basic typing and
editing techniques you use in almost any Windows word
processing program. As you type, text wraps from line to line.

$ Procedures

1. Click Start.

2. Point to Programs.

3. Point to Accessories.

4. Select Notepad.
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% Step-by-Step

Open the Notepad and a blank document.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Programs.
The Programs submenu appears. Click  Programs

3. Point to Accessories.
The Accessories submenu appears.

Point to 
Accessories

4. Select Notepad.
The Notepad window opens with a
blank document.

Click  Notepad

SAVING A FILE IN NOTEPAD

! Discussion

You can save a file in Notepad as you would in any Windows application. The first
time a file is saved, you must specify a filename and the location to which the file will
be saved. From then on, you can save the file without specifying the name or location.

"
You can also save a file with the File...Save As command,
which allows you to save a previously named file under a
different filename and leave the original file intact.

$ Procedures

1. Select the File pull-down menu.

2. Select Save.

3. Enter a name for the file.

4. Select the Save in location.

5. Select Save.
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% Step-by-Step

Save a file in Notepad. First, type your name and address. Open Notepad, if necessary.

Steps Practice Data

1. Select the File pull-down menu.
The File pull-down menu appears.

Click File

2. Select Save.
The Save As dialog box opens if the
file has not been previously saved.

Click Save

3. Enter a name for the file.
The filename appears in the File name
box.

Type Sample File

4. Select the Save in location.
The location appears in the Save in
box.

Click the Student Data
Folder

5. Select Save.
The file is saved in ASCII format with
an extension of .txt.

Click Save

Close the Notepad and delete the file from the Student Data Folder.

USING PAINT

! Discussion

The Paint accessory is a drawing application. Although it is not as sophisticated as a
standalone drawing application, it has some versatile drawing features. It contains
three drawing tools: a pencil, a paintbrush with various tips, and an airbrush with
different spray volumes. It draws straight and curved lines, rectangles, ellipses, and
polygons. The custom colors can be mixed or you can use color palettes from other
programs. Objects can be flipped, rotated, skewed, and stretched.

The Windows NT Paint program is very similar to the Windows 3.1 PaintBrush
program, however it can only save files in the .bmp format. Paint has several
enhancements that also make it superior to the PaintBrush program, such as Print
Preview and Set as Wallpaper.



Lesson 14 - Using Accessories Windows NT Basics

Page 152 University Technology Training Center

Paint

$ Procedures

1. Click Start.

2. Point to Programs.

3. Point to Accessories.

4. Select Paint.

% Step-by-Step

Open the Paint program.
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Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Programs.
The Programs submenu appears. Point to  Programs

3. Point to Accessories.
The Accessories submenu appears.

Point to 
Accessories

4. Select Paint.
The Paint program opens.

Click  Paint

Review the menu to see the new commands. Close the Paint program.

USING WORDPAD

! Discussion

WordPad is a basic word processing program that contains a few features such as
setting tabs, formatting text, adding bullet lists, aligning paragraphs, and finding
specified text strings. The operations in WordPad are similar to the way operations are
performed in Microsoft Word. Since it is a basic program, however, it does not check
spelling, create headers and footers, generate tables, etc. WordPad reads Microsoft
Word 6.0 files (DOC), Write files (WRI), Rich Text Format (RTF), and ASCII files
(TXT). It writes all these formats except Write files (WRI).

WordPad
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$ Procedures

1. Click Start.

2. Point to Programs.

3. Point to Accessories.

4. Select WordPad.

% Step-by-Step

Open WordPad.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Programs.
The Programs submenu appears. Point to  Programs

3. Point to Accessories.
The Accessories submenu appears.

Point to 
Accessories

4. Select WordPad.
WordPad opens with a blank
document.

Click  WordPad

OPENING A DOCUMENT

! Discussion

Like other Windows programs, WordPad allows you to open an existing file. The
method used to open a document is the same as in any other Windows application.

"
As a shortcut, you can double-click the filename to open a file.
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$ Procedures

1. Click the Open button .

2. Select the Look in location.

3. Select the file.

4. Select Open.

% Step-by-Step

Open an existing file. Open WordPad, if necessary.

Steps Practice Data

1. Click the Open button.
The Open dialog box opens. Click 

2. Select the Look in location.
The location appears in the Look in
box.

Click the Memos Sent
folder in the Student Data
Folder

3. Select the file.
The file is selected.

Click Timesheet

4. Select Open.
The file opens in WordPad.

Click Open

ADDING AND EDITING TEXT

! Discussion

To add text to a document in WordPad, you can use the basic typing techniques you
use in almost any Windows word processing program. As you type, text wraps from
line to line. The [Enter] key ends a line or creates a blank line. To insert text, you can
click the insertion point in the desired location and type the text. To delete text, you
can highlight the text and press [Delete], or select Edit...Cut.
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FORMATTING TEXT

! Discussion

WordPad allows you to format text with a font type, font style, size, and effects.

Formatting text

"
As a shortcut, select the text and select a font style or size
from the lists in the format bar.

$ Procedures

1. Select the text you want to format.

2. Select the Format pull-down menu.

3. Select Font.

4. Select the desired font options.

5. Select OK.
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% Step-by-Step

Format text in the Timesheet document.

Steps Practice Data

1. Select the text you want to format.
The text appears highlighted in the
document.

Double-click the word
Memo in the title

2. Select the Format pull-down menu.
The Format pull-down menu appears.

Click Format

3. Select Font.
The Font dialog box opens.

Click Font

4. Select the desired font options.
Font selections are indicated in the
dialog box.

Click the Arial font

5. Select OK.
The selected text appears with the new
formatting.

Click OK

SAVING A FILE

! Discussion

You can save a file in WordPad as you would in any Windows application. The first
time a file is saved, the Save As dialog box opens and you must specify a filename
and a location to which the file will be saved. From then on, you can save the file
without specifying the name or location.

"
You can also save a file under a different filename using the
Save As command from the File pull-down menu.

$ Procedures

1. Click the Save button .
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% Step-by-Step

Save a file. Open WordPad, if necessary.

Steps Practice Data

1. Click the Save button.
The file is saved. Click 

Close WordPad.
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EXERCISE

WINDOWS ACCESSORIES

# Task

Use Accessories.

1. Open the Calculator. View both the scientific and standard
calculators.

2. Use either calculator to compute the following: 192 * .012 + 69.
Close the Calculator.

3. Open the WordPad accessory.

4. Type your name.

5. Copy your name to the Clipboard by selecting it, clicking the right
mouse button, and selecting Copy.

6. Then, open the Clipboard Viewer and view its contents.

7. Delete the contents of the Clipboard, then close the Clipboard
Viewer.

8. Open the Recommendation file in the Accounting folder of the
Student Data Folder in WordPad. Change the font and size of the
letterhead text. Italicize the word Please in the last paragraph of the
letter. Save the file.

9. Close all open windows.





LESSON 15 -
CHANGING TIME SETTINGS

In this lesson, you will learn how to:

• Change the date

• Change the time

• Change the time zone

• Set daylight savings time



Lesson 15 - Changing Time Settings Windows NT Basics

Page 162 University Technology Training Center

CHANGING THE DATE

! Discussion

Usually the computer’s date is set when the computer is assembled and, if the battery-
operated clock/calendar is working properly, the date is always correct. However,
circumstances may occur in which you might need to change the date on the
computer. For example, if you are afraid that you have a virus that will erase your
hard disk on a certain date, you can change the date on the computer the day before
the virus is scheduled to attack. Another reason it may be important to you to make
sure that the computer’s date is correct is because Windows NT “stamps” the date that
files are created or modified.

Changing the date

"
As in Windows 3.1, the Windows NT Date/Time icon is
available in the Control Panel. In Windows NT, however, the
Date/Time settings are controlled through Date/Time
properties and, therefore, are maintained with Date/Time
property sheets.
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Date/Time icon.

5. Select the month arrow.

6. Select a month from the list of options.

7. Select the correct year using the arrows.

8. Click the day of the month in the calendar.

9. Select OK.

% Step-by-Step

Change the date of the computer to the current date, if necessary.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Control Panel.
The Control Panel window opens.

Click  Control Panel

4. Double-click the Date/Time icon.
The Date/Time Properties window
opens. Double-click 

5. Select the month arrow.
The month list appears.

Click the month 

6. Select a month from the list of options.
The selected month appears in the
month box.

Click the current month, if
necessary

7. Select the correct year using the
arrows.
The correct year appears in the year
box.

Click the arrows to select
the correct year
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Steps Practice Data

8. Click the day of the month in the
calendar.
The current date is highlighted in the
calendar.

Click the current date in
the calendar

9. Select OK.
The system clock is set with the current
date.

Click OK

Close the Control Panel window.

CHANGING THE TIME

! Discussion

Because Windows NT “stamps” the time that files are created or modified, it may be
important to you that the computer’s time is correct.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Date/Time icon.

5. Specify the correct time in the time box.

6. Select OK.

% Step-by-Step

Change the time in the computer to the correct time, if necessary.



Windows NT Basics Lesson 15 - Changing Time Settings

University Technology Training Center Page 165

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Control Panel.
The Control Panel Window opens.

Click  Control Panel

4. Double-click the Date/Time icon.
The Date/Time Properties window
opens. Double-click 

5. Specify the correct time in the time
box.
The correct time appears in the time
box.

Accept the default time

6. Select OK.
The system time changes to the correct
time.

Click OK

Close the Control Panel window.

CHANGING THE TIME ZONE

! Discussion

Windows NT allows you to set the time zone for your computer by locating the time
zone on a map or by selecting the time zone from a list of options. Each listed time
zone includes its difference, in hours, to the Greenwich Mean Time in Greenwich,
England. When traveling between time zones, this feature can be used as a reference
to determine the correct time setting for your computer.
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The Time Zone property sheet

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Date/Time icon.

5. Select the Time Zone tab.

6. Choose your time zone in the pull down menu, by selecting the down
arrow button.

7. Select OK.

% Step-by-Step

Change the time zone for the computer, if necessary.
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Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Control Panel.
The Control Panel window opens.

Click  Control Panel

4. Double-click the Date/Time icon.
The Date/Time Properties window
opens. Double-click 

5. Select the Time Zone tab.
The Time Zone property sheet
appears.

Click Time Zone

6. Select a time zone.
Use the pull down menu above the
map.

Select a time zone, by
highlighting the zone in
the pull down menu and
releasing your mouse.

7. Click OK.
The time zone property is set on your
computer.

Click OK

Reset the time zone by selecting your time zone from the list of options. Close the
Control Panel window.

SETTING DAYLIGHT SAVINGS TIME

! Discussion

Windows NT will automatically reset the computer’s time to accommodate daylight
savings time if the daylight savings time option is selected in the Time Zone property
sheet of the Date/Time Properties window. On the day that the time changes, when
you turn on your computer, Windows NT gives you a message before starting that it
has changed the time for you.

$ Procedures

1. Click Start.
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2. Point to Settings.

3. Select Control Panel.

4. Double-click the Date/Time icon.

5. Select the Time Zone tab.

6. Select the Automatically adjust clock for daylight saving changes
option.

7. Select OK.

% Step-by-Step

Allow Windows NT to change the time for you when daylight savings time goes into
effect.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Control Panel.
The Control Panel window opens.

Click  Control Panel

4. Double-click the Date/Time icon.
The Date/Time Properties window
opens. Double-click 

5. Select the Time Zone tab.
The Time Zone property sheet
appears.

Click Time Zone

6. Select the Automatically adjust clock
for daylight saving changes option.
The option is checked.

Check  Automatically
adjust clock for daylight
saving changes, if
necessary

7. Select OK.
The new setting is saved in Windows
NT.

Click OK

Close the Control Panel window.
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EXERCISE

CHANGING DATE & TIME SETTINGS

# Task

Change date and time settings.

1. Change the computer’s date to January 1, 1996.

2. Then, change the time to 8:00 AM.

3. Next, change the time zone to Greenwich Mean Time and allow for
daylight savings changes.

4. Finally, return all settings to reflect your current date, time, and time
zone.

5. Close all open windows.





LESSON 16 -
USING THE DOCUMENTS MENU

In this lesson, you will learn how to:

• Open recently used documents

• Clear the Documents menu
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OPENING RECENTLY USED DOCUMENTS

! Discussion

The Windows NT Start menu includes a Documents command. When you point to
this command, a submenu appears with a list of recently opened documents.  From
this submenu, you can select a document to open quickly it in its parent application.

"
Some programs will not add files to the Documents submenu.

$ Procedures

1. Click Start.

2. Point to Documents.

3. Select the document you want to open.

CLEARING THE DOCUMENTS MENU

! Discussion

The last 15 documents that have been opened appear on the Documents menu.
Although it is impossible to delete documents individually from this menu, it is
possible to delete all the documents from the menu.  After the Documents menu
reaches the 15 document limit, the oldest document (filename) at the top of the menu
are removed as new documents (filenames) are added to the bottom of the list.

"
If the Documents menu is clear already, the Clear button will
not be available.



Windows NT Basics Lesson 16 - Using the Documents Menu

University Technology Training Center Page 173

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Taskbar.

4. Select the Start Menu Programs tab.

5. Select Clear.

6. Select OK.

% Step-by-Step

If no documents currently appear on the Documents menu, open two documents from
the desktop by double-clicking any text files from the Student Data Folder and then
closing those files. Open the Taskbar Properties dialog box.

Steps Practice Data

1. Select the Start Menu Programs tab.
The Start Menu Programs property
sheet appears.

Click Start Menu
Programs

2. Select Clear.
The documents are removed from the
Documents menu.

Click Clear

3. Select OK.
The Taskbar Properties dialog box
closes.

Click OK

To verify that the Documents menu is empty, click the Start button and point to
Documents.
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EXERCISE

USING THE DOCUMENTS MENU

# Task

Work with the Documents menu.

1. Open recently used documents from the Documents menu.

2. Clear the Documents menu.



LESSON 17 -
CUSTOMIZING MENUS

In this lesson, you will learn how to:

• Add items - Start menu

• Remove items - Start menu

• Add items - Programs menu

• Remove items - Programs menu

• Change icon size on menus
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ADDING ITEMS - START MENU

! Discussion

You can customize the Start menu by adding items for your most frequently-used
programs, files, folders, or shortcuts. Items that you add to the Start menu are placed
above the default items in the menu and separated from them with a line.

Changes to the taskbar’s Start menu are made in the Start Menu Programs property
sheet of the Taskbar Properties dialog box.

Adding items to the Start menu

"
An easy way to add an item to the Start menu is to drag the
object’s icon to the Start button. The new item will be located
at the top of the Start menu.

"
The Taskbar Properties dialog box can also be accessed by
clicking the right mouse button on the taskbar and selecting
Properties from the shortcut menu.
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Taskbar.

4. Select the Start Menu Programs tab.

5. Select Add.

6. Type the location and name of the item.

7. Select Next.

8. Select the Start menu in the picture of the hierarchy.

9. Select Next.

10. Type a name for the item.

11. Select Finish.

12. Select OK.

% Step-by-Step

Add an item to the Start menu.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Taskbar.
The Taskbar Properties dialog box
opens.

Click  Taskbar...

4. Select the Start Menu Programs tab.
The Start Menu Programs property
sheet appears.

Click Start Menu
Programs

5. Select Add.
The Create Shortcut wizard appears.

Click Add...
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Steps Practice Data

6. Type the location and name of the
item.
The location and name appear in the
Command Line box.

Type c:\winnt

7. Select Next.
The Select Program Folder window
opens.

Click Next >

8. Select the Start menu in the picture of
the hierarchy.
The Start Menu icon is highlighted.

Click  Start Menu

9. Select Next.
The Select a Title for the Program
window opens.

Click Next >

10. Type a name for the item.
The name appears in the Select a
name for the shortcut box.

Type Windows Folder

11. Select Finish.
The wizard closes.

Click Finish

12. Select OK.
The Taskbar Properties dialog box
closes and the new item is added to the
Start menu.

Click OK

To confirm that the program was added, click the Start button view the added
Windows Folder at the top of the Start menu.

REMOVING ITEMS - START MENU

! Discussion

Only items that have been added by you can be removed from the Start menu.
Default items cannot be removed.

You can remove Start menu items in the Start Menu Programs property sheet of the
Taskbar Properties dialog box.
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Taskbar.

4. Select the Start Menu Programs tab.

5. Select Remove.

6. Select the item to remove.

7. Select Remove.

8. Select Close.

9. Select OK.

% Step-by-Step

Remove an item from the Start menu. Open the Taskbar Properties dialog box.

Steps Practice Data

1. Select the Start Menu Programs tab.
The Start Menu Programs property
sheet appears.

Click Start Menu
Programs

2. Select Remove.
The Remove Shortcuts/Folders dialog
box opens.

Click Remove...

3. Select the item to remove.
The item is highlighted.

Click  Windows
Folder

4. Select Remove.
The highlighted item is removed from
the tree.

Click Remove

5. Select Close.
The dialog box closes.

Click Close

6. Select OK.
The Taskbar Properties dialog box
closes.

Click OK

Check that the menu item has been deleted from the Start menu.
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ADDING ITEMS - PROGRAMS MENU

! Discussion

The Programs menu has two kinds of menu items. One type of item launches an
application immediately. Another type of item is denoted with an arrow and displays a
submenu. By adding a folder to the Programs menu, you create a menu item that
displays a submenu consisting of items representing objects in the folder.

$ Procedures

1. Click the right mouse button on the Start button.

2. Select Open.

3. Double-click the Programs icon.

4. Select the File pull-down menu.

5. Point to New.

6. Select Folder.

7. Type the name you want the item to have on the Programs menu.

8. Press [Enter].

9. Double-click the new folder you just created.

10. Select the File pull-down menu.

11. Point to New.

12. Select Shortcut.

13. Type the path and name of the executable file.

14. Select Next.

15. Type the name you want the program to have on the submenu.

16. Select Finish.

% Step-by-Step

Add an item to the Programs menu that displays a submenu.
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Steps Practice Data

1. Click the right mouse button on the
Start button.
A shortcut menu appears.

Click the right mouse
button on  Start

2. Select Open.
The Start Menu window opens.

Click Open

3. Double-click the Programs icon.
A window containing all the objects on
the Programs menu opens.

Double-click 

4. Select the File pull-down menu.
The File pull-down menu appears.

Click File

5. Point to New.
A submenu appears.

Point to New

6. Select Folder.
A new icon is created.

Click Folder

7. Type the name you want the item to
have on the Programs menu.
The name appears under the folder
icon.

Type Welcome

8. Press [Enter].
The name is assigned to the folder.

Press [Enter]

9. Double-click the new folder you just
created.
The folder window opens.

Double-click the new
Welcome folder

10. Select the File pull-down menu.
The File pull-down menu appears.

Click File

11. Point to New.
A submenu appears.

Point to New

12. Select Shortcut.
The Create Shortcut wizard opens.

Click Shortcut

13. Type the path and name of the
executable file.
The location and name of the file
appear in the Command Line box.

Type
c:\windows\welcome.exe

14. Select Next.
The Select a Title for the Program
window opens.

Click Next >
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Steps Practice Data

15. Type the name you want the program
to have on the submenu.
The name appears in the Select a
name for the shortcut box.

Type Windows Welcome

16. Select Finish.
The folder window is visible with an
icon for the new item.

Click Finish

To add additional programs to the submenu, follow steps 1 through 3; then open the
item to which you want to add more programs and follow steps 10 through 16.

Close the folder window when you are finished adding programs.

To see the new item on the Programs menu, click the Start button, point to
Programs, and point to Disk Utility.

Close any open windows.

REMOVING ITEMS - PROGRAMS MENU

! Discussion

If you delete a program or folder from the hard disk, you should also delete the
program or folder item from the Programs menu; otherwise your menu will be
inaccurate.

When you remove a program from the Programs menu, the program file is not
deleted from the hard drive. Likewise, when you remove a program from the hard
drive, it is not automatically removed from the Programs menu.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Taskbar.

4. Select the Start Menu Programs tab.

5. Select Remove.

6. Select the item to remove.



Windows NT Basics Lesson 17 - Customizing Menus

University Technology Training Center Page 183

7. Select Remove.

8. Select Yes, if prompted.

9. Select Close.

10. Select OK.

% Step-by-Step

Delete a program from the Programs menu. Open the Taskbar Properties dialog box.

Steps Practice Data

1. Select the Start Menu Programs tab.
The Start Menu Programs property
sheet appears.

Click Start Menu
Programs

2. Select Remove.
The Remove Shortcuts/Folders dialog
box opens.

Click Remove...

3. Select the item to remove.
The item is highlighted.

Click Disk Utility

4. Select Remove.
A dialog box prompts you to verify
your deletion if you are deleting a
folder. If you are deleting an item, no
verification is necessary.

Click Remove...

5. Select Yes, if prompted.
The verification is confirmed.

Click Yes

6. Select Close.
The dialog box closes.

Click Close

7. Select OK.
The Taskbar Properties dialog box
closes.

Click OK

Check that the program has been deleted from the Programs menu.
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CHANGING ICON SIZE ON MENUS

! Discussion

If the Start menu or any of its cascading submenus, such as the Programs menu,
have more options than will fit in one column, the menu size increases to multiple
columns. By making the size of the icons smaller, you may have enough room to
contain all options in a single column.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Taskbar.

4. Check the Show small icons in Start menu option.

5. Select OK.

% Step-by-Step

Change the size of the icons on the Start menu and all its cascading submenus. Open
the Taskbar Properties dialog box.

Steps Practice Data

1. Check the Show small icons in Start
menu option.
The option is checked.

Check  Show small
icons in Start menu

2. Select OK.
The Taskbar Properties dialog box
closes.

Click OK

To see the difference in size, click the Start button, then return the icon size to its
default. Perform this task by removing the check from the Show small icons in Start
menu option in the Taskbar Properties dialog box.
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EXERCISE

CUSTOMIZING MENUS

# Task

Customize the Start and Programs menus.

1. Add the Student Data Folder to the Start menu.

2. Add the Fonter program (found in the Shareware folder of the
Student Data Folder) to the Programs menu.

3. Delete all items that you have added to the Start menu.

4. Delete the Fonter program from the Programs menu.





LESSON 18 -
STARTING PROGRAMS AUTOMATICALLY

In this lesson, you will learn how to:

• Start autoexecuting programs

• Remove autoexecuting programs
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STARTING AUTOEXECUTING PROGRAMS

! Discussion

If you have a particular program you use every time you start your computer, you can
have Windows NT open that program automatically each time it starts. This type of
program is referred to as an “autoexecuting” program. You can make a program
autoexecute by placing it in the StartUp folder. You are not limited to one
autoexecuting program. You can have Windows NT open as many programs as you
want.

"
You are not limited to one autoexecuting program; you can
have Windows NT open as many programs as you want.

$ Procedures

1. Click the Start button.

2. Point to Settings.

3. Select Taskbar.

4. Select the Start Menu Programs tab.

5. Select Add.

6. In the Command line box, type the path and name of the executable
file. (Quotation marks must be placed around the path name if has
spaces in it.)

7. Select Next.

8. Scroll as necessary and select the StartUp folder.

9. Select Next.

10. Type a name for the program.

11. Select Finish.

12. Select OK.
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% Step-by-Step

Set up a program to autoexecute when Windows NT starts.

Steps Practice Data

1. Click the Start button.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Taskbar.
The Taskbar Properties dialog box
opens.

Click  Taskbar...

4. Select the Start Menu Programs tab.
The Start Menu Programs property
sheet appears.

Click Start Menu
Programs

5. Select Add.
A Create Shortcut dialog box opens.

Click Add...

6. In the Command line box, type the
path and name of the executable file.
(Quotation marks must be placed
around the path name if has spaces in
it.)
The file and path name appear in the
box.

Type “c:\Winnt\system32\
mspaint.exe” (The
quotation marks are
necessary because the path
name has spaces in it.)

7. Select Next.
The hierarchy of the Start menu
displays with Programs selected.

Click Next >

8. Scroll as necessary and select the
StartUp folder.
The StartUp folder is selected.

Scroll as necessary and
click the StartUp folder

9. Select Next.
You are prompted for additional
information.

Click Next >

10. Type a name for the program.
A name for the program appears.

Type MS Paint

11. Select Finish.
The process is completed.

Click Finish

12. Select OK.
The Taskbar Properties dialog box
closes.

Click OK
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Close any open windows. Restart your computer to test these steps. Then, close all
open windows.

REMOVING AUTOEXECUTING PROGRAMS

! Discussion

You can remove autoexecuting programs that were placed in the StartUp folder. The
StartUp folder holds programs, which execute automatically when Windows NT
starts.

$ Procedures

1. Click the Start button.

2. Point to Settings.

3. Select Taskbar.

4. Select the Start Menu Programs tab.

5. Select Remove.

6. Scroll as necessary and click the plus sign (+) preceding the StartUp
folder to expand the list of options contained within it.

7. Select the menu item that you want to delete from the StartUp
menu.

8. Select Remove.

% Step-by-Step

Remove a program from the StartUp folder.

Steps Practice Data

1. Click the Start button.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings
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Steps Practice Data

3. Select Taskbar.
The Taskbar Properties dialog box
opens.

Click  Taskbar...

4. Select the Start Menu Programs tab.
The Start Menu Programs property
sheet appears.

Click Start Menu
Programs

5. Select Remove.
The Remove Shortcuts/Folders dialog
box opens.

Click Remove...

6. Scroll as necessary and click the plus
sign (+) preceding the StartUp folder
to expand the list of options contained
within it.
The StartUp folder expands to show its
subfolders.

Scroll as necessary and
click the plus sign (+)
before the StartUp folder

7. Select the menu item that you want to
delete from the StartUp menu.
The item is selected.

Click MS Paint

8. Select Remove.
The object is removed from the
StartUp folder.

Click Remove

Close any open windows. Reboot your computer to test the removal of the program.
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EXERCISE

USING AUTOEXECUTING PROGRAMS

# Task

Set up an autoexecuting program, then remove it.

1. Add WordPad to the StartUp folder to make it autoexecute.

2. Restart your computer.

3. Then, remove WordPad from the StartUp folder.

4. Restart your computer again.



LESSON 19 -
CUSTOMIZING THE DISPLAY

In this lesson, you will learn how to:

• Use the display properties

• Use patterns

• Use wallpaper

• Use a screen saver

• Modify a screen saver

• Use passwords - screen savers

• Customize desktop fonts

• Change desktop components

• Change to a different scheme

• Create a scheme

• Delete a scheme

• Change the screen resolution
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USING THE DISPLAY PROPERTIES

! Discussion

The Display Properties dialog box controls the background and the appearance of the
desktop, the screen saver, and the settings for the monitor. As you make changes to
the background, screen saver, appearance, or monitor settings, you can click the
Apply command button to apply the changes without closing the Display Properties
dialog box. This option allows you to change the settings on all property sheets before
closing the Display Properties dialog box.

The Display Properties dialog box

"
You can also access the Display Properties dialog box by
clicking the right mouse button on any empty area of the
desktop and selecting Properties from the shortcut menu.
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Display object.

% Step-by-Step

Open the Display object in the Control Panel.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Control Panel.
The Control Panel window opens.

Click  Control Panel

4. Double-click the Display object.
The Display Properties dialog box
opens.

Double-click 

USING PATTERNS

! Discussion

In addition to wallpaper, Windows NT also provides several patterns you can use for
the background of the desktop. Patterns automatically fill the entire screen. You can
use a pattern and a wallpaper together, but the wallpaper will cover the pattern unless
you choose the Center option for the wallpaper so that the size of the bitmap
wallpaper file does not fill the entire screen.

"
If you choose the (None) option for the wallpaper and the
(None) option for the pattern, the desktop background is a
solid color.
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Display object.

5. Scroll as necessary to select a pattern from the Pattern list.

6. Select OK.

% Step-by-Step

Apply a pattern to the desktop. Open the Display Properties dialog box.

Steps Practice Data

1. Scroll as necessary to select a pattern
from the Pattern list.
A sample of the pattern displays.

Scroll as necessary to
select Buttons

2. Select OK.
Windows NT saves your settings.

Click OK

View the pattern on the desktop. Then, return the desktop to its default by selecting
(None) in the Pattern list of the Display Properties dialog box.

USING WALLPAPER

! Discussion

Wallpaper is a graphic consisting of a predefined combination of colors and patterns
that you can apply to your desktop. Several wallpaper designs are available in
Windows NT. Wallpaper designs are bitmapped files, which can be created, in many
drawing programs, including Paint. Therefore, in addition to the wallpaper designs
supplied by Windows NT, you can create or obtain bitmapped files to use for different
backgrounds on your desktop. For example, you could scan an image of a photograph,
save the file in the .bmp format, and use it as wallpaper.
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The wallpaper designs supplied by Windows NT must be tiled to cover the entire
screen. Tiling creates a repeating design for files that have a definite pattern. Bitmap
designs that have a textured look rather than a pattern appear to be one large file when
they are tiled. You also can choose to center a design on the desktop.

"
If you choose the (None) option for the wallpaper and the
(None) option for the pattern, the desktop background is a
solid color.

"
To use a bitmapped file that is not supplied by Windows NT,
copy the file into the Windows folder and it will be listed with
the default wallpaper designs.

"
If you create your own wallpaper using Paint to create a .bmp
file, you can apply the wallpaper from within the Paint
program.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Display object.

5. Select a wallpaper design from the Wallpaper list.

6. Select a Display option.

7. Select OK.

% Step-by-Step

Apply a wallpaper design to the desktop. Open the Display Properties dialog box.
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Steps Practice Data

1. Select a wallpaper design from the
Wallpaper list.
A sample of the wallpaper displays.

Click winnt

2. Select a Display option.
The option is darkened.

Click  Tile

3. Select OK.
Your wallpaper selection is applied to
the desktop.

Click OK

After viewing the desktop, remove the wallpaper by selecting (None) in the
Wallpaper list of the Display Properties dialog box.

USING A SCREEN SAVER

! Discussion

A screen saver does exactly what its name implies; it saves the screen. If an image is
allowed to stay on your computer’s monitor for too long, it can be “burned-in” which
means that the screen continually displays a “ghost” of the image even when the
monitor is not on. Constant use of a computer causes the screen to refresh itself so that
images are not burned in; the problem arises when the computer is left idle with an
image displayed on the monitor.

A screen saver is designed to start automatically after a specified period of inactivity
(called wait time in Windows NT) and then the screen saver changes the image on the
screen continually or blanks out the screen completely. When you move the mouse or
press a key, the screen saver image is replaced by the underlying screen image. (When
you press a key to remove the screen saver image, the underlying program ignores the
keystroke.)
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Changing your screen saver

"
Windows NT provides several screen savers, but does not
install all the screen savers by default. If your installation of
Windows NT does not include all the screen savers, you can
add them using the Windows Setup property sheet of the
Add/Remove Programs dialog box, which is accessible from
the Control Panel window.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Display object.

5. Select the Screen Saver tab.



Lesson 19 - Customizing the Display Windows NT Basics

Page 200 University Technology Training Center

6. Select the Screen Saver arrow.

7. Select a screen saver from the Screen Saver list.

8. Specify a wait time by typing a number or using the arrows.

9. Select OK.

% Step-by-Step

Activate a screen saver. Open the Display Properties dialog box.

Steps Practice Data

1. Select the Screen Saver tab.
The Screen Saver property sheet
appears.

Click Screen Saver

2. Select the Screen Saver arrow.
The Screen Saver list appears.

Click Screen Saver 

3. Select a screen saver from the Screen
Saver list.
The screen saver is selected and a
sample of the screen saver displays.

Click Starfield
Simulation

4. Specify a wait time by typing a
number or using the arrows.
The wait time is specified.

Change the wait time to 1
minute, if necessary

5. Select OK.
The screen saver settings are saved.

Click OK

To test the screen saver, allow your computer to remain inactive (no mouse or
keyboard activity) for 1 minute.

MODIFYING A SCREEN SAVER

! Discussion

The screen savers provided by Windows NT can be modified in limited ways. For
example, you can change the settings (including speed and usually the colors) for
most screen savers. If you have a screen saver that displays text, you can usually
change the text. Screen savers based on geometric lines and curves can be changed by
increasing or decreasing the number of lines or curves. Screen saver settings are
controlled in the Options dialog box.
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Modifying a screen saver

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Display object.

5. Select the Screen Saver tab.

6. Select the Screen Saver arrow.

7. Select the screen saver you want to modify.

8. Select Settings.

9. Make the desired changes.

10. Select OK.

11. Select OK.

% Step-by-Step

Modify the attributes of a screen saver. Open the Display Properties dialog box.
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Steps Practice Data

1. Click the Screen Saver tab.
The Screen Saver property sheet
appears.

Click Screen Saver

2. Select the Screen Saver arrow.
The Screen Saver list appears.

Click Screen Saver 

3. Select the screen saver you want to
modify.
The screen saver is selected.

Click Starfield
Simulation, if necessary

4. Select Settings.
The Options dialog box opens for the
selected screen saver.

Click Settings...

5. Make the desired changes.
The changes are reflected in the
Options dialog box.

Change the warp speed to
Fast, if necessary

6. Select OK.
The changes are saved.

Click OK

7. Select OK.
The Display Properties dialog box
closes.

Click OK

USING PASSWORDS - SCREEN SAVERS

! Discussion

Password protecting a screen saver protects your screen from being read by someone
else in your absence. When you leave your computer unattended, the screen saver
automatically starts after the specified waiting period (the period of inactivity).
Moving the mouse or striking a key, displays a dialog box that prompts you to type
your screen saver password. The underlying screen will not display unless the
password is correctly entered.

"
Passwords are case-sensitive.
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Display object.

5. Select the Screen Saver tab.

6. Select the screen saver you want to password-protect from the
Screen Saver list.

7. Check the Password protected option.

8. Select Change.

9. Type the new password in the New password box.

10. Type the password again to confirm it in the Confirm new
password box.

11. Select OK.

12. Select OK to respond to the confirmation.

13. Select OK.

CUSTOMIZING DESKTOP FONTS

! Discussion

You can specify the font size, color, and style you want to use for almost any text
component displayed on the desktop. This customization includes text under icons, as
well as text within a windows’ title bar, menus, message boxes, and tips.
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Changing desktop fonts

"
You can quickly access the Display Properties dialog box by
clicking the right mouse button on any blank area of the
desktop.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Display object.

5. Select the Appearance tab.

6. Select the Item arrow.
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7. Select the item to which you want to apply the font from the Item
list.

8. Select the Font arrow.

9. Select a font you want to change from the list.

10. Select the Size arrow.

11. Select a font size you want to change from the list.

12. Click the Bold button , if desired.

13. Click the Italic button , if desired.

14. Select OK.

% Step-by-Step

Change the font size, color, or style of fonts used on the desktop. Open the Display
Properties dialog box.

Steps Practice Data

1. Select the Appearance tab.
The Appearance property sheet
appears.

Click Appearance

2. Select the Item arrow.
The Item list appears.

Click Item 

3. Select the item to which you want to
apply the font from the Item list.
The selected item’s current font, size,
color, and style display on the line
below the item.

Click Icon

4. Select the Font arrow.
The Font list appears.

Click Font 

5. Select a font you want to change from
the list.
The font is selected.

Click Times New
Roman

6. Select the Size arrow.
The Size list appears.

Click Size 

7. Select a font size you want to change
from the list.
The font size is selected.

Click 8
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Steps Practice Data

8. Click the Bold button, if desired.
The font is bolded.

Click 

9. Click the Italic button, if desired.
The font is italicized.

Click 

10. Select OK.
The new font settings are applied to
the text.

Click OK

View the changes in the text on your desktop. Then, return the text to its default
settings of MS Sans Serif, 8, with no bold or italics.

CHANGING DESKTOP COMPONENTS

! Discussion

If you want to change the color and/or size of an individual component of your
desktop, you can select the component on the Appearance property sheet of the
Display Properties dialog box and specify the new color and/or size.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Display object.

5. Select the Appearance tab.

6. Select the Item arrow.

7. Select a component from the Item list.

8. Double-click the contents of the Size box.

9. Specify the size (in pixels) by typing the size or using the arrows.

10. Select the Color arrow.

11. Select a color from the Color palette, if applicable.

12. Select OK.
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% Step-by-Step

Change the size and/or color of an individual component of the desktop. Open the
Display Properties dialog box.

Steps Practice Data

1. Select the Appearance tab.
The Appearance property sheet
appears.

Click Appearance

2. Select the Item arrow.
The Item list appears.

Click Item 

3. Select a component from the Item list.
The component is selected.

Click Menu

4. Double-click the contents of the Size
box.
The number is highlighted.

Double-click the contents
in the Size box

5. Specify the size (in pixels) by typing
the size or using the arrows.
The new size appears.

Type 22

6. Select the Color arrow.
The Color palette appears.

Click Color 

7. Select a color from the Color palette,
if applicable.
The color is selected.

Click white

8. Select OK.
The new settings are applied and
saved.

Click OK

View the changes, then return the component to its original default settings with a size
of 20 and color of light gray.

CHANGING TO A DIFFERENT SCHEME

! Discussion

A scheme is a set of colors and font attributes used for all the components of the
desktop. Windows NT provides several schemes from which you can choose and also
allows you to create custom schemes. You can switch to another scheme at any time
in the Appearance property sheet of the Display Properties dialog box.
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Display object.

5. Select the Appearance tab.

6. Select the Scheme arrow.

7. Scroll as necessary to select a scheme from the Scheme list.

8. Select OK.

% Step-by-Step

Change to a different scheme. Open the Display Properties dialog box.

Steps Practice Data

1. Select the Appearance tab.
The Appearance property sheet
appears.

Click Appearance

2. Select the Scheme arrow.
The Scheme list appears.

Click Scheme 

3. Scroll as necessary to select a scheme
from the Scheme list.
The scheme is selected.

Scroll as necessary to
select Spruce

4. Select OK.
The selected scheme is applied to
Windows NT.

Click OK

Reset the scheme back to Windows Standard.
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CREATING A SCHEME

! Discussion

In addition to the schemes that Windows NT provides for the desktop, you can create
your own schemes by specifying the colors and sizes of individual components and
saving the collection of settings as a new scheme.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Display object.

5. Select the Appearance tab.

6. Select the Item arrow.

7. Select the first component from the Item list.

8. If appropriate for the item, specify the size (in pixels) by typing the
size or using the arrows.

9. Select the Color arrow.

10. Select a color for the component.

11. Select the next component from the Item list.

12. If appropriate for the item, specify the size (in pixels) by typing the
size or using the arrows.

13. Select the Color arrow.

14. Select a color for the component.

15. Select Save As.

16. Type a name for the new scheme.

17. Select OK.

18. Select OK.
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% Step-by-Step

Create a new window scheme by customizing the colors of two window components.
Windows Standard should be the initial window scheme. Open the Display
Properties dialog box.

Steps Practice Data

1. Select the Appearance tab.
The Appearance property sheet
appears.

Click Appearance

2. Select the Item arrow.
The Item list appears.

Click Item 

3. Select the first component from the
Item list.
The component is selected.

Click Inactive Title Bar

4. If appropriate for the item, specify the
size (in pixels) by typing the size or
using the arrows.
The new size appears.

Change the font size to 15
pixels

5. Select the Color arrow.
The Color palette appears.

Click Color 

6. Select a color for the component.
The color is selected.

Click red

7. Select the next component from the
Item list.
The component is selected.

Click Menu

8. If appropriate for the item, specify the
size (in pixels) by typing the size or
using the arrows.
The new size appears.

Change the size to 15
pixels

9. Select the Color arrow.
The Color palette appears.

Click Color 

10. Select a color for the component.
The color is selected.

Click yellow

11. Select Save As.
The Save Scheme dialog box opens.

Click Save As...

12. Type a name for the new scheme.
The new name appears.

Type My Scheme
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Steps Practice Data

13. Select OK.
The scheme is saved with the assigned
name.

Click OK

14. Click OK.
The Display Properties dialog box
closes.

Click OK

You can change as many windows components as desired. Open My Computer and
the Recycle Bin to view the color of the title bar for the inactive window. Display the
toolbar in one of the windows and point to a tool to see the new color of the ToolTip.
Close all open windows.

DELETING A SCHEME

! Discussion

If you want to limit the number of schemes that are available for use, or you have a
few schemes that you know you will never use, you can delete the schemes to
conserve disk space.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Display object.

5. Select the Appearance tab.

6. Select the Scheme arrow.

7. Select a scheme from the Scheme list.

8. Select Delete.

% Step-by-Step

Delete a scheme. Open the Display Properties dialog box.
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Steps Practice Data

1. Select the Appearance tab.
The Appearance property sheet
appears.

Click Appearance

2. Select the Scheme arrow.
The Scheme list appears.

Click Scheme 

3. Select a scheme from the Scheme list.
The scheme is selected.

Click My Scheme

4. Select Delete.
The selected scheme is deleted.

Click Delete

Reset the scheme back to Windows Standard and close the Display Properties dialog
box.

CHANGING THE SCREEN RESOLUTION

! Discussion

If you have a monitor and adapter card that support a resolution greater than 640 by
480 pixels, you can change the resolution of the monitor in the Settings property sheet
of the Display Properties dialog box. Using a higher resolution makes the objects on
the desktop smaller with greater definition.
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Changing the screen resolution

"
If no monitor was recognized during installation, you will be
prompted to specify a display type before Windows NT can
change the screen resolution.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Display object.

5. Select the Settings tab.

6. Drag the slider in the Desktop area.

7. Release the mouse button.
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8. Select OK.

9. Select Yes.
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EXERCISE

CUSTOMIZING THE DISPLAY

# Task

Customize the Display properties.

1. Change the background of the desktop to a wallpaper or a pattern of
your choice.

2. Select a color scheme of your choice.

3. Activate a different screen saver and change the wait time to two
minutes.

4. Change the screen resolution to 16 color.

5. Return the desktop to its default settings.





LESSON 20 -
CUSTOMIZING THE MOUSE

In this lesson, you will learn how to:

• Adjust the cursor blink rate

• Reverse mouse buttons

• Adjust double-click speed

• Choose mouse pointer schemes

• Choose mouse pointer shapes

• Adjust mouse speed

• Activate the pointer trails

• Adjust the pointer trails
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ADJUSTING THE CURSOR BLINK RATE

! Discussion

Windows NT allows you to adjust the rate at which the cursor blinks between a very
slow blink and a very rapid blink. The blink rate can be adjusted in the Speed property
sheet of the Keyboard Properties dialog box, which is accessible from the Control
Panel window.

Adjusting the cursor blink rate

$ Procedures

1. Click Start.

2. Point to Settings.
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3. Select Control Panel.

4. Double-click the Keyboard icon.

5. Drag the slider under Cursor blink rate.

6. Release the mouse button.

7. Click OK.

% Step-by-Step

Adjust the blink rate of the cursor.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Control Panel.
The Control Panel window opens.

Click  Control Panel

4. Double-click the Keyboard icon.
The Keyboard Properties dialog box
opens. Double-click 

5. Drag the slider under Cursor blink
rate.
The slider moves as you drag.

Drag the indicator two
increments to the left

6. Release the mouse button.
The sample blinking cursor displays
the new blink rate.

Release the mouse button

7. Select OK.
The new cursor blink rate is saved.

Click OK

Return the cursor blink rate to its original setting, the eighth increment.

REVERSING MOUSE BUTTONS

! Discussion

The default setting for a mouse designates the left button as the primary button and the
right button as the secondary button. This setting should be reversed for left-handed
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users. You can reverse mouse buttons in the Buttons property sheet of the Mouse
Properties dialog box, which is accessible from the Control Panel window.  For those
users who have the IntelliMouse, with added mouse features, the reverse mouse
button is located on the Basics property sheet of the Mouse Properties dialog box.

Reversing mouse buttons

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Mouse object.

5. Select the desired Button configuration or Button selection (with
the IntelliMouse) option.

6. Select OK.
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% Step-by-Step

Switch buttons on the mouse.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Control Panel
The Control Panel window opens.

Click  Control Panel

4. Double-click the Mouse object.
The Mouse Properties dialog box
opens.

Double-click 

5. Select the desired Button
configuration or Button selection
(with the IntelliMouse)
The selected option is darkened.

Select the configuration
option not currently
selected

6. Select OK.
The Mouse Properties dialog box
closes and the mouse buttons are
switched.

Click OK

Change the mouse button assignments back to the default. Remember, the mouse
buttons have been reversed.

ADJUSTING DOUBLE-CLICK SPEED

! Discussion

Double-clicking the mouse button effectively can be frustrating for new users. If
double-clicking presents a problem, Windows NT allows you to adjust the speed of
the double-click so that it is more suited to your needs. The Mouse Properties dialog
box, where the double-click speed is set, has a test area that allows you to test the
double-click speed before you make a final selection.
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Mouse object.

5. Drag the slider for the Double-click speed.

6. Release the mouse button.

7. Point to the Jack-in-the-Box and double-click the mouse or double-
click in the test area box to set the speed (with the IntelliMouse).

8. Repeat steps 5 and 6 until you are satisfied with the double-click
speed.

9. Click OK.

% Step-by-Step

Adjust the double-click speed of the mouse. Open the Mouse Properties dialog box.

Steps Practice Data

1. Drag the slider for the Double-click
speed.
IntelliMouse – Double-click in the
Cloud box to set the speed.

Drag the slider to the left
to make the double-click
speed slightly slower, or
double-click in the Clouds
box to set your speed.

2. Release the mouse button.
The double-click speed is adjusted.

Release the mouse button

3. Point to the Jack-in-the-Box and
double-click the mouse.
If you have double-clicked the mouse
button with the appropriate speed, the
Jack will pop out of the box.

IntelliMouse - Double-click on the
Test box to the right of the Cloud box.
If you have double-clicked the mouse
button with the appropriate speed, the
Umbrella will open.

Double-click the Jack-in-
the-Box or the Test box
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Steps Practice Data

4. Select OK.
The Mouse Properties dialog box
closes.

Click OK

Return the double-click speed to the middle of the bar.

CHOOSING MOUSE POINTER SCHEMES

! Discussion

Windows NT provides several appearance schemes for mouse pointers and allows you
to create your own. The schemes provided use the standard Windows symbols for the
various shapes of the pointers, but one scheme is three-dimensional and other schemes
use larger sizes. Mouse pointer schemes are controlled in the Pointers property sheet
of the Mouse Properties dialog box.

In addition to the schemes provided by Windows NT, you can purchase programs
which provide additional sets of pointer shapes. Pointer shapes are stored in ANI or
CUR files. You can select any CUR or ANI file that is stored on your disk to
substitute for any pointer in a scheme. (One ANI file comes with Windows NT.)
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Choosing mouse pointer schemes

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Mouse object.

5. Select the Pointers tab.

6. Select the Scheme arrow.

7. Select a scheme from the Scheme list.

8. Select OK.
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% Step-by-Step

Select a mouse pointer scheme. Open the Mouse Properties dialog box.

Steps Practice Data

1. Select the Pointers tab.
The Pointers property sheet appears.

Click Pointers

2. Select the Scheme arrow.
The Scheme list appears.

Click Scheme 

3. Select a scheme from the Scheme list.
All the pointers used in the scheme
display.

Click Dinosaur

4. Select OK.
The selected scheme is applied.

Click OK

Return the pointer scheme back to (None).

CHOOSING MOUSE POINTER SHAPES

! Discussion

Windows NT provides support for the use of different mouse pointer shapes. You can
also purchase programs that provide additional sets of pointer shapes. Pointer shapes
are stored in ANI or CUR files. You can select any CUR or ANI file that is stored on
your disk to substitute for any pointer in a scheme. (One ANI file comes with
Windows NT.)

"
You can save new mouse pointer shape assignments as a
mouse pointer scheme by selecting the Save As command
button from the Pointers property sheet and assigning a name
to the new scheme.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.
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4. Double-click the Mouse object.

5. Select the Pointers tab.

6. Select a scheme from the Scheme list.

7. Select a pointer from the list.

8. Select Browse.

9. Select the desired ANI or CUR file. (The Browse dialog box should
default to view the Cursors folder.)

10. Select Open.

11. Repeat steps 7 through 10 for each pointer that you want to change.

12. Select OK.

% Step-by-Step

Select a different shape for the mouse pointer. Open the Mouse Properties dialog box.

Steps Practice Data

1. Select the Pointers tab.
The Pointers property sheet appears.

Click Pointers

2. Select a pointer from the list.
The pointer is selected.

Click the Busy pointer

3. Select Browse.
The Browse dialog box opens.

Click Browse...

4. Select the desired ANI or CUR file.
(The Browse dialog box should default
to view the Cursors folder.)
The file is selected.

Scroll, if necessary, and
click barber

5. Select Open.
The file opens.

Click Open

6. Select OK.
The mouse pointers are changed.

Click OK

Set the barber pointer scheme back to the default by selecting the Use Default
command button.
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ADJUSTING MOUSE SPEED

! Discussion

The speed at which the mouse pointer moves on the screen can be adjusted to make
the pointer faster or slower with the same level of mouse manipulation. The slower the
mouse pointer moves, the easier it is for most people to control. Mouse pointer speed
is controlled in the Motion or Basics (for the IntelliMouse) property sheet of the
Mouse Properties dialog box.

      Adjusting mouse speed

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.
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4. Double-click the Mouse object.

5. Select the Motion or Basics tab.

6. Drag the slider under Pointer speed to adjust the speed.

7. Release the mouse button.

8. Click OK.

% Step-by-Step

Adjust the speed of the mouse pointer. Open the Mouse Properties dialog box.

Steps Practice Data

1. Select the Motion or Basics tab.
The Motion property sheet appears.

Click Motion or Basics

2. Drag the slider under Pointer speed to
adjust the speed.
The slider moves as you drag.

Drag the slider to the right

3. Release the mouse button.
The pointer speed is adjusted.

Release the mouse button

4. Select OK.
The mouse pointer speed settings are
saved.

Click OK

Reset the mouse pointer speed to its original (middle of the bar) setting.
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EXERCISE

CUSTOMIZING THE MOUSE

# Task

Customize the Mouse properties.

1. Adjust the blink rate of the cursor to make it a little faster.

2. Make the mouse pointer move a little faster.

4. Choose 3D pointers for the pointer scheme of the mouse pointer.

. Return the pointer scheme to [None].

Return the Mouse properties to their defaults.





LESSON 21 -
DELETING FILES DIRECTLY

In this lesson, you will learn how to:

• Delete folders/files directly
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DELETING FOLDERS/FILES DIRECTLY

! Discussion

Windows NT allows you to bypass the Recycle Bin and permanently remove folders
and files as you delete them. Removing folders and files using this method is faster
than deleting them to the Recycle Bin. However, if you choose to use this method, all
folders and files that you delete bypass the Recycle Bin and are deleted immediately.

"
If the computer has more than one hard disk drive, you have to
select the Use one setting for all drives option to make a
global setting.

&
If you choose to bypass the Recycle Bin, any folders and files
that you delete cannot be recovered.

$ Procedures

1. Click the right mouse button on the Recycle Bin.

2. Select Properties.

3. Select the Global tab.

4. Check the Do not move files to the Recycle Bin. Remove files
immediately on delete option to bypass the Recycle Bin when
deleting objects from this point forward.

5. Select OK to confirm that the entry is correct.

6. Select a file to be deleted.

7. Press [Delete].

8. Select Yes to confirm that the deletion is correct.
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% Step-by-Step

Change the Global property sheet associated with the Recycle Bin to delete the Copy
to Hours Worked object directly, bypassing the Recycle Bin. Use My Computer to
open the Student Data Folder.

Steps Practice Data

1. Click the right mouse button on the
Recycle Bin.
A shortcut menu appears.

Click the right mouse
button on the Recycle Bin

2. Select Properties.
The Recycle Bin Properties dialog box
opens.

Click Properties...

3. Select the Global tab.
The Global property sheet appears.

Click Global, if necessary

4. Check the Do not move files to the
Recycle Bin. Remove files
immediately on delete option to
bypass the Recycle Bin when deleting
objects from this point forward.
The option is checked.

Check  Do not move
files to the Recycle
Bin. Remove files
immediately on delete

5. Select OK to confirm that the entry is
correct.
The Recycle Bin Properties dialog box
closes.

Click OK

6. Select a file to be deleted.
The file is selected.

Click 

7. Press [Delete].
A confirmation dialog box opens.

Press [Delete]

8. Select Yes to confirm that the deletion
is correct.
The file is deleted permanently.

Click Yes

Remove the check from the Do not move files to the Recycle Bin. Remove files
immediately on delete option to return the Recycle Bin’s Global property sheet to its
default state. Close any open windows.
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EXERCISE

DELETING FILES DIRECTLY

# Task

Delete files directly and bypass the Recycle Bin. Open the Student Data Folder before
proceeding.

1. Set the properties for the Recycle Bin so that you can delete files and
folders directly.

2. Delete the Delete Me Document file from the Student Data Folder.

3. Check to verify that the file is not present in the Recycle Bin.

4. Return the Recycle Bin properties to their default settings so that
deleted files and folders can be restored.

Close any open windows.



LESSON 22 -
WORKING WITH FONTS

In this lesson, you will learn how to:

• Use the Fonts folder

• Add new fonts

• View fonts

• Print a font sample

• Delete fonts
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USING THE FONTS FOLDER

! Discussion

Windows NT stores all the fonts that are installed on your computer in the Fonts
folder, a subfolder of the Winnt folder. Several TrueType fonts are included with
Windows NT including Arial, Courier, Symbol, and Times New Roman. The Fonts
folder has special features associated with it that allow you to install and remove
fonts, view and print samples of fonts, and list fonts by similarity. The easiest way to
open the Fonts folder is to use the shortcut located in the Control Panel.

The Fonts folder

"
Like other windows, the Fonts window has a toolbar that
provides shortcuts to menu items. By default, the toolbar is not
visible.

"
If  you do not want a separate listing for each attribute of the
same font, such as Arial, Arial Bold, Arial Italic, choose the
View pull-down menu and select Hide Variations.
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Fonts folder.

% Step-by-Step

Use the shortcut in the Control Panel to open the Fonts folder.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Control Panel.
The Control Panel window opens.

Click  Control Panel

4. Double-click the Fonts folder.
The Fonts window opens.

Double-click 

ADDING NEW FONTS

! Discussion

Many fonts are added to your system automatically when you install programs such as
Microsoft Word or WordPerfect for Windows, which include their own fonts.
Additionally, you can purchase font packages and install fonts with the Fonts folder
in the Control Panel.
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Adding new fonts

"
If you do not check the Copy fonts to Windows folder
option, you must use the fonts from the local or network drive
in which they reside.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Fonts folder.

5. Select the File pull-down menu.

6. Select Install New Font.

7. Select the Drives arrow.

8. Select the drive that holds the disk with the new fonts you want to
install.

9. Select the folder containing the new fonts in the Folders list.

10. Scroll as necessary to select the font you want to install from the list.

11. Check the Copy fonts to Fonts folder option.
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12. Select OK.

% Step-by-Step

Install a new font. Open the Fonts folder, if necessary.

Steps Practice Data

1. Select the File pull-down menu.
The File pull-down menu appears.

Click File

2. Select Install New Font.
The Add Fonts dialog box appears.

Click Install New
Font...

3. Select the Drives arrow.
The Drives list appears.

Click Drives 

4. Select the drive that holds the disk
with the new fonts you want to install.
The drive appears in the Drives box.

Click  a:

5. Select the folder containing the new
fonts in the Folders list.
The List of fonts list displays fonts
available in the selected folder.

Double-click the
Shareware folder

6. Scroll as necessary to select the font
you want to install from the list.
The font is highlighted in the list.

Scroll as necessary to
select WhatA-Relief
Regular (True Type)

7. Check the Copy fonts to Fonts folder
option.
The option is checked.

Check  Copy fonts to
Fonts folder

8. Select OK.
The Add Fonts dialog box closes and
the font is added to the Fonts window.

Click OK

VIEWING FONTS

! Discussion

Every font has its own style and characteristics that make it distinctive and suited to a
specific use. For example, the font called Brush Script would be appropriate for a
formal invitation, but it would not be appropriate for the text of a long document like a
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magazine article. Since there are so many fonts and it is impossible to remember what
they all look like, Windows NT provides a method to view fonts.

Viewing a font

"
When viewing a font, a sample of the font appears, as well as
information about the font, including typeface name, file size,
and copyright information.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Fonts folder.

5. Click the right mouse button on the desired font.

6. Select Open.

7. Select Done after viewing the font.
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% Step-by-Step

Open and view a font. Open the Fonts folder, if necessary.

Steps Practice Data

1. Click the right mouse button on the
desired font.
A shortcut menu appears.

Click the right mouse

button on 

2. Select Open.
The font view window opens and
displays font information and samples
of the font.

Click Open

3. Select Done after viewing the font.
The font view window closes.

Click Done

PRINTING A FONT SAMPLE

! Discussion

When trying to select an appropriate font, it may be enough to view the font, but
sometimes it is better to print a sample of a font. Even though the view of the font is
WYSIWYG (What You See Is What You Get), the most accurate view of a font is a
printed one.

"
If you are using different fonts and it is an important part of
the work that you do, print a sample of each font on your
system and use the pages as a printed reference.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Fonts folder.
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5. Click the right mouse button on the desired font.

6. Select Open.

7. Select Print.

8. Select OK.

9. Select Done when finished.

% Step-by-Step

Open and print a sample font. Open the Fonts folder, if necessary.

Steps Practice Data

1. Click the right mouse button on the
desired font.
A shortcut menu appears.

Click the right mouse

button on 

2. Select Open.
The font view window opens.

Click Open

3. Select Print.
The Print dialog box opens.

Click Print

4. Select OK.
The sample prints and the view of the
font redisplays.

Click OK

5. Select Done when finished.
The font view window closes.

Click Done

DELETING FONTS

! Discussion

If you have similar fonts with different names installed on your system, you may want
to remove the similar fonts to make more hard disk space available. You can use the
feature that lists fonts by similarity to search for fonts that are similar and then view
the fonts to help you decide which fonts to delete.
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Fonts folder.

5. Scroll as necessary and click the right mouse button on the font you
want to delete.

6. Select Delete.

7. Select Yes, if prompted.

% Step-by-Step

Delete a font from your system. Open the Fonts folder, if necessary.

Steps Practice Data

1. Scroll as necessary and click the right
mouse button on the font you want to
delete.
A shortcut menu appears.

Scroll as necessary and
click the right mouse

button on 

2. Select Delete.
A confirmation window appears.

Click Delete

3. Select Yes, if prompted.
The font is deleted.

Click Yes

Close all open windows.
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EXERCISE

WORKING WITH FONTS

# Task

Work with fonts.

1. Open the Fonts folder and select a font to open.

2. List fonts by similarity.

3. Install ApplePi Regular (found in the Shareware folder in the
Student Data Folder).

4. View ApplePi Regular.

5. Delete ApplePi Regular.



LESSON 23 -
ADDING/REMOVING COMPONENTS

In this lesson, you will learn how to:

• Check installed components

• Add components

• Remove components
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CHECKING INSTALLED COMPONENTS

! Discussion

In Windows NT, you can choose which components of the operating system you want
to install on your computer.

You can check to see which components are installed at any time in the Windows NT
Setup property sheet of the Add/Remove Programs Properties dialog box. In this
dialog box, you can also add or remove individual Windows NT components.

The Add/Remove Programs Properties dialog box displays categories of components.
Categories that have a white box with a check have all components within that
category installed. Categories that have no check or have a check with a gray box,
have components which are not installed. You can view the details for each category
to determine which components are present on your computer.

Checking installed components
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Add/Remove Programs object.

5. Select the Windows Setup tab.

6. Check the category for which you want to view the actual
components.

7. Select Details.

8 Select OK.

9. Select OK.

% Step-by-Step

Check to see which Windows NT communications components are installed on your
system.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Control Panel.
The Control Panel window opens.

Click  Control Panel

4. Double-click the Add/Remove
Programs object.
The Add/Remove Programs dialog box
opens.

Double-click 
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Steps Practice Data

5. Select the Windows Setup tab.
The Windows Setup property sheet
appears. Categories that have no
check, or have a check with a gray
box, have components, which are not
installed.

Click Windows NT
Setup

6. Check the category for which you
want to view the actual components.
The category is checked.

Check   Click
Communications

7. Select Details.
A dialog box opens showing the
components of that category.

Click Details...

8 Select OK.
The dialog box closes.

Click OK

9. Select OK.
The Add/Remove Programs Properties
dialog box closes.

Click OK

ADDING COMPONENTS

! Discussion

After you have installed Windows NT, you can install additional components, such as
Windows NT tools or utilities, that were not installed earlier. To perform this task,
you must have the Windows NT installation disks or CD, or you must have access to a
directory on the network containing the Windows NT installation program.

Windows components are added through the Add/Remove Programs Properties dialog
box. This dialog box shows categories of components, such as Accessories, Disk
Tools, and Communications. Categories that appear with a blank box have no
components installed. Categories that appear grayed with a check have some, but not
all, components installed. Categories with a check have all components installed. The
Details command button opens a dialog box for a selected category that shows all
components within the category and which specific components have been installed.
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Adding components

"
Windows NT may prompt you to insert an installation diskette
to add the selected component.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Add/Remove Programs object.

5. Select the Windows Setup tab.

6. Check the category of the component you want to install or select the
category if it is checked but the box is gray.

7. Select Details.
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8. Check the component you want to install.

9. Select OK.

10. Select OK.

% Step-by-Step

Add an uninstalled Windows NT component. Open the Control Panel window, if
necessary.

Steps Practice Data

1. Double-click the Add/Remove
Programs object.
The Add/Remove Programs dialog box
opens.

Double-click 

2. Select the Windows Setup tab.
The Windows Setup property sheet
appears. Categories that have no
check, or have a check with a gray
box, have components, which are not
installed.

Click Windows NT
Setup

3. Check the category of the component
you want to install or select the
category if it is checked but the box is
gray.
The category is checked.

Check  
Accessories, if
necessary

4. Select Details.
A dialog box opens showing the
components of that category.

Click Details

5. Check the component you want to
install.
The component is checked.

Accept the listed
components

6. Select OK.
The dialog box closes.

Click OK

7. Select OK.
The Add/Remove Programs Properties
dialog box closes.

Click OK

Close the Control Panel window.
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REMOVING COMPONENTS

! Discussion

After you have installed Windows NT, you can remove components that are not being
used to conserve disk space.

Windows components are removed through the Add/Remove Programs Properties
dialog box. This dialog box shows categories of components, such as Accessories,
Disk Tools, and Communications. Categories that appear with a blank box have no
components installed. Categories that appear grayed with a check have some, but not
all, components installed. Categories with a check have all components installed. The
Details command button opens a dialog box for a selected category that shows all
components within the category and which specific components have been installed.
Unchecking the component’s box will uninstall that specific component, while
unchecking a category’s box will uninstall all components within that category.

"
The next time Windows NT starts, it will take a little longer
than usual because it will have to update system files to reflect
your changes.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Control Panel.

4. Double-click the Add/Remove Programs object.

5. Select the Windows NT Setup tab.

6. Uncheck the category of the component you want to remove or select
it if it has multiple components and you do not want to remove them
all.

7. If you do not want to remove all the components in the selected
category, Select Details.

8. Uncheck the components that you want to remove.

9. Select OK.

10. Select OK.
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EXERCISE

CHECKING INSTALLED COMPONENTS

# Task

Check the components installed on your computer.

1. Check each category for uninstalled components. View the Details
dialog box for each category to check individual components.



LESSON 24 -
USING PRINTERS

In this lesson, you will learn how to:

• Create a printer shortcut

• Specify a default printer

• Print with shortcut menus

• Print with drag and drop

• View the print queue

• Pause the printer

• Change the order of print jobs

• Cancel a print job

• Purge the print queue
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CREATING A PRINTER SHORTCUT

! Discussion

Windows NT allows you to place printer icons on the desktop. Sometimes it is
inconvenient to open the printer folder and then drag files to the printer icon. You can
put a shortcut to a printer on the desktop to make it more accessible.

$ Procedures

1. Click the Start button.

2. Point to Settings.

3. Select Printers.

4. Hold the right mouse button on a printer icon and drag it to the
desktop.

5. Release the mouse button when the icon is on the desktop.

6. Select Create Shortcut(s) Here.

% Step-by-Step

Place a shortcut to a printer on the desktop.

Steps Practice Data

1. Click the Start button.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Printers.
The Printers window opens.

Click  Printers

4. Hold the right mouse button on a
printer icon and drag it to the desktop.
The printer icon moves to the desktop.

Hold the right mouse
button on the printer icon
and drag it to the desktop
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Steps Practice Data

5. Release the mouse button when the
icon is on the desktop.
A shortcut menu appears.

Release the right mouse
button

6. Select Create Shortcut(s) Here.
The shortcut is created.

Click Create
Shortcut(s) Here

Close the Printers window.

SPECIFYING A DEFAULT PRINTER

! Discussion

 If you have several printers installed on your system, one printer should be designated
as the default printer. This printer should be the one you use most often. When you
print a file in an application program, the file is sent to the default printer
automatically, but in most cases, you can select a different printer before the file is
sent to print.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Printers.

4. Click the right mouse button on the printer you want as the default.

5. Select Set As Default.

% Step-by-Step

Set a printer as the default.
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Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Printers.
The Printers window opens and
displays icons for all available
printers.

Click  Printers

4. Click the right mouse button on the
printer you want as the default.
A shortcut menu appears.

Click the right mouse
button on any printer icon

5. Select Set As Default.
The printer is set as the default
printer.

Click Set As Default

Reset the printer to its original default.

Close the Printers window.

PRINTING WITH SHORTCUT MENUS

! Discussion

You can print a document using a shortcut menu if the program that created the
document is located on your system. When you print a file, Windows NT opens the
program that created the file, opens the file, sends the file to the printer using the
default settings for the application, then closes the file and the program.

$ Procedures

1. Click the right mouse button on the file you want to print.

2. Select Print.

% Step-by-Step

Print a document in a Windows program using a shortcut menu.
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Steps Practice Data

1. Click the right mouse button on the
file you want to print.
A shortcut menu appears.

Click the right mouse
button on any file

2. Select Print.
Windows NT prints the file.

Click Print

Close all open windows.

PRINTING WITH DRAG AND DROP

! Discussion

An easy way to send a file to the printer from Windows NT is to drag the file’s icon to
the printer icon. If the program that created the file is on the system, Windows NT
will open the program, open the file, print the file using the program’s default print
settings, then close the file and the program.

If you plan to use drag and drop to print frequently, create a shortcut for the printer on
your desktop so that you do not have to open the Printers window each time you want
to print.

"
You can print multiple files by dragging them to a printer
icon.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Printers.

4. Double-click the My Computer icon.

5. Double-click the drive necessary to locate the folder.

6. Double-click the folders necessary to locate the file you wish to
print.

7. Drag the file to the icon of the printer in the Printers window.
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8. Release the mouse button.

% Step-by-Step

Send a file to the printer using drag and drop.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Printers.
The Printers window opens.

Click  Printers

4. Double-click the My Computer icon.
The My Computer window opens.

Double-click 

5. Double-click the drive necessary to
locate the folder.
The folders appear in a window.

Double-click the drives
necessary to view the
Student Data Folder and
the Memos Sent subfolder

6. Double-click the folders necessary to
locate the file you wish to print.
The files appear in a window.

Double-click the folders
necessary to view the
Student Data Folder and
the Memos Sent subfolder

7. Drag the file to the icon of the printer
in the Printers window.
The file moves as you drag.

Drag any file to the icon
for the default printer

8. Release the mouse button.
Windows NT prints the file.

Release the mouse button

Close all open windows.
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VIEWING THE PRINT QUEUE

! Discussion

Documents that are waiting to be printed are stored in the “print queue.” You can
view the print queue to see a list of the documents waiting to print and the order in
which they will print.

"
Each printer has its own print queue.

"
A printer icon displays beside the time in the taskbar when
documents are sent to a printer. You can open the print queue
by pointing to the printer icon in the taskbar, clicking the right
mouse button, and selecting the name of the printer in the
shortcut menu.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Printers.

4. Double-click the icon for the printer.

% Step-by-Step

Open the print queue for viewing.

Steps Practice Data

1. Click Start.
The Start menu appears.

Click  Start

2. Point to Settings.
The Settings submenu appears. Point to  Settings

3. Select Printers.
The Printer window opens.

Click  Printers
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Steps Practice Data

4. Double-click the icon for the printer.
The print queue window opens.

Double-click any printer
icon

Close all open windows.

PAUSING THE PRINTER

! Discussion

For various reasons, you may need to pause the printer while it is in the middle of
printing a file. Using commands in the print queue, you can pause the printing and
resume it again when you are ready without ever touching a button on the printer
itself.

"
To resume printing, select Pause Printing from the
Document pull-down menu in the print queue window. This
option will remove the check from the menu command and
continue your print job.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Printers.

4. Double-click the icon for the printer.

5. Select the print job you want to pause.

6. Select the Document pull-down menu.

7. Select Pause Printing.
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CHANGING THE ORDER OF PRINT JOBS

! Discussion

When several files are sent to the same printer to be printed, the files are printed in the
order they were sent. If a file waiting to be printed needs to be printed sooner than
other files in the print queue before it, you can move the file up in the queue. You also
can move a file down in the queue so that it is printed later than its original position.

"
You cannot move a print job to the top of the queue to replace
the job that is currently printing. Nor can you move the job
that is currently printing to a different position in the print
queue.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Printers.

4. Double-click the icon for the printer.

5. Drag the print job to the desired location in the queue.

6. Release the mouse button.

CANCELING A PRINT JOB

! Discussion

Although application programs usually have commands that cancel a print job, you
also can cancel a print job from the Windows NT print queue. When a print job that is
printing is canceled, it may not stop printing instantly because the printer must print
the data that is still in its memory buffer. If the buffer is large enough, it could contain
the remainder of the file and, therefore, canceling the print job has no effect.
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$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Printers.

4. Double-click the icon for the printer.

5. Select the print job you want to cancel.

6. Select the Document pull-down menu.

7. Select Cancel Printing.

PURGING THE PRINT QUEUE

! Discussion

Purging the print queue cancels all print jobs currently in the print queue, including
the job that is currently printing. Canceled print jobs, however, will not stop printing
until the printer’s memory buffer is emptied.

$ Procedures

1. Click Start.

2. Point to Settings.

3. Select Printers.

4. Double-click the icon for the printer.

5. Select the Printer pull-down menu.

6. Select Purge Print Jobs.
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EXERCISE

USING PRINTERS

# Task

Use Printers.

1. Use the shortcut menu to print any document from the Student Data
Folder.

2. Use drag and drop to print another document from the Student Data
Folder.

3. View the print queue for the default printer.

4. Close all open windows.





LESSON 25 -
USING MY BRIEFCASE

In this lesson, you will learn how to:

• Use My Briefcase

• Make direct cable connections

• Synchronize files

• Check folder or file status

• Split a folder or file
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USING MY BRIEFCASE

! Discussion

My Briefcase in Windows NT allows you to copy files from one computer, modify
them on another computer, and then synchronize the original files with the modified
files. This utility is a useful for people who take files to another location (like home or
on the road) to work on and then bring them back to the office. When you transfer
files, there is always the danger of writing over the most up-to-date file. My Briefcase
solves this problem by replacing unmodified files with modified files. If both files
have changed, Windows opens the program that created the files (if it is available) to
merge the different versions.

The general steps for using My Briefcase are as follows: copy the files from the
primary computer to My Briefcase, move My Briefcase to a floppy disk, edit the files
in My Briefcase using the remote computer, insert the floppy disk into the primary
computer and update the files.

$ Procedures

1. Insert a diskette into the A: drive of your primary computer.

2. Drag the files or folders on which you will be working to the My
Briefcase icon on the desktop.

3. Release the mouse button.

4. Move My Briefcase to the diskette in your primary computer’s A:
drive.

5. Remove the diskette from your primary computer. You can now
modify the files on the diskette on your other computer as necessary.

6. Insert the diskette with the modified My Briefcase files into your
primary computer’s diskette drive.

7. Move My Briefcase from the diskette back to the desktop of your
primary computer.

8. Double-click the My Briefcase icon on your desktop.

9. Select the Briefcase pull-down menu.

10. Select Update All.
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SYNCHRONIZING FILES

! Discussion

With a direct cable connection, you can use My Briefcase to synchronize files
between computers. This process is a convenient way to share or copy a large number
of files between two desktop computers or a desktop computer and a portable
computer.

$ Procedures

1. Connect the computers using a direct cable connection.

2. Drag the file or folder to the My Briefcase icon on the desktop.

3. Release the mouse button.

4. Modify the folder or file in My Briefcase or in its original location.

5. Double-click the My Briefcase icon on the desktop.

6. Select the folders or files you want to update.

7. Select the Briefcase pull-down menu.

8. Select Update All or Update Selection, as applicable.

9. Select Update.

CHECKING FOLDER OR FILE STATUS

! Discussion

You can check the status of any folder or file in My Briefcase to determine if it has
been synchronized with its original.

$ Procedures

1. Double-click the My Briefcase icon on the desktop.

2. Select the folders or files on which you want to check the status.
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3. Select the File pull-down menu.

4. Select Properties.

5. Select the Update Status tab.

6. Select OK to close the dialog box.

SPLITTING A FOLDER OR FILE

! Discussion

You may want to maintain a folder or file in My Briefcase separate from its original.
When you want to perform this task, you must split the folder or file.

"
When you split a folder or file, its status becomes an orphan
and it is no longer updated.

$ Procedures

1. Double-click the My Briefcase icon on the desktop.

2. Select the folders or files you want to split.

3. Select the Briefcase pull-down menu.

4. Select Split From Original.

5. Select Yes.
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EXERCISE

USING MY BRIEFCASE

# Task

The following questions test your knowledge of the concepts learned working with
My Briefcase.

1. What are the four basic steps for using My Briefcase?

2. What type of connection must be made to use My Briefcase to
synchronize files between two computers?

3. Which property sheet do you use to check the synchronized status of
a folder or file in My Briefcase?

4. What do you need to do to maintain a folder or file in My Briefcase
from its original?





INDEX

Advanced searches
by content of file, 131
by file size, 131
by file type, 131
performing, 131

Applications
minimizing simultaneously, 33
restoring simultaneously, 33

Autoexecuting programs
removing, 190
starting, 188

Calculator
performing calculations, 146
scientific mode, 144
standard mode, 144
using, 144
What's This?, 144

Clipboard Viewer
Clipboard, 147
using, 147

Components
adding, 246
checking installed, 244
removing, 249

Cursor blink rate
adjusting, 216

Date
changing, 162

Desktop
using, 2

Desktop components
changing, 205

Desktop fonts
customizing, 203

Dialog boxes
options, 54
using, 54

Direct cable connection
synchronizing files, 265

Display properties
using, 194

Documents
opening recently used, 172

Drag and drop
copying objects, 60
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moving objects, 61
Files

copying, 86
creating, 83
deleting, 92
deleting directly, 230
finding by date, 129
finding by name, 126
long filenames, 83
moving, 85
renaming, 84
retrieving deleted, 93
sending to a diskette, 87

Folders
copying, 81
creating, 78
deleting directly, 230
finding by date, 129
finding by name, 126
moving, 80
renaming, 79
retrieving deleted, 93
sending to a diskette, 82
status bar, 44
using, 68

Fonts
adding, 235
deleting, 240
printing a sample, 239
viewing, 237

Fonts folder
using, 234

Help
Contents, 98
context-sensitive, 104
copying text from a help topic, 105
finding key words and phrases, 102
getting in dialog boxes, 104
Index, 100
printing help topics, 107

Help topics
changing fonts, 106

Icons
arranging on desktop, 8
Auto Arrange, 9
lining up, 10

Keyboard
restarting, 138
shutting down, 140
switching windows, 28

Menus
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changing the icon size, 184
shortcut menus, 50
Start menu, 50
submenus, 50
using, 50

Mouse button
adjusting double-click speed, 219
reversing, 217

Mouse pointer
adjusting mouse speed, 225
choosing schemes, 221
choosing shapes, 223

My Briefcase
check folder/file status, 265
split folders/files, 266
synchronizing files, 265
using, 264

My Computer
changing the view, 69
Dial-Up Networking, 68
starting a program, 73
using, 3
viewing a diskette, 72
viewing resources, 68
viewing the hard drive, 71

Notepad
log feature, 148
saving files, 150
using, 148

Objects
changing the display, 45
selecting a block, 38
selecting multiple, 39

Paint
using, 151

Patterns
using, 195

Printer shortcuts
creating, 252

Printing
canceling a print job, 259
changing the order of print jobs, 259
drag and drop, 255
pausing the printer, 258
print queue, 257
purging the print queue, 260
shortcut menus, 254
specifying a default printer, 253
viewing documents before, 257

Programs menu
adding items, 180
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removing items, 182
Property sheets

using, 62
Quick View

using, 124
Recycle Bin

configuring, 91
deleting files, 92
emptying, 94
retrieving deleted objects, 93
using, 4

Schemes
changing, 207
creating, 208
deleting, 210

Screen
changing the resolution, 211

Screen savers
modifying, 200
passwords, 202
using, 198

Shortcut menus
copying objects, 59
moving objects, 58
starting programs, 56
using, 55

Shortcuts
creating, 88
renaming, 90

Start menu
adding items, 176
removing items, 178
restarting, 139
shutting down, 137
using, 51

Taskbar
hide/display, 14
moving, 15
switching windows, 27
using, 3
using the clock, 16

Tasks
ending, 53

Time
changing, 164
daylight savings time, 167

Time zone
changing, 165

View toolbar
buttons/controls, 42
using, 42
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Wallpaper
using, 196

Welcome to Windows 95 dialog box
closing, 136

Windows
closing, 26
minimizing simultaneously, 33
moving, 23
opening, 20
restoring simultaneously, 33
scrolling, 25
sizing, 24
switching, 27, 28
tiling, 31

Windows 95
starting, 136

Windows Explorer
copying files, 117
copying folders, 117
creating folders, 116
deleting files, 120
deleting folders, 120
moving files, 119
moving folders, 119
opening objects, 114
replacing File Manager, 112
using, 112
viewing your computer, 113

WordPad
adding text, 155
editing text, 155
formatting text, 156
opening a document, 154
saving files, 157
using, 153


